Introduction to Microsoft™ Applications
Using MS Office 2016

By Barbara G. Ellsworth

Ellsworth Publishing Co.

For course description, demo, current syllabus, and interactive review, visit us at: www.EllsworthPublishing.com
Introduction to Microsoft 2016 Applications—
Publisher, Excel, PowerPoint, Access

It Doesn’t Get Any Easier!

By
Barbara Grace Ellsworth
Mesa Community College
Mesa, Arizona
Introduction to Microsoft Applications
By
Barbara Grace Ellsworth
Mesa Community College
Mesa, Arizona

Copyright © 2008-2016 Version 1.0
By ELLSWORTH PUBLISHING COMPANY
Chandler, Arizona

ALL RIGHTS RESERVED

Copyright terms of usage:

Users are defined as current instructors at a public education facility and their students. No part of this book may be used with or combined with products not copyrighted by Ellsworth Publishing Company (EPC).

Permission is granted to current users of EPC products to: (1) Print and/or duplicate this book for use in a public education institution, and (2) share this book in electronic format via school network; so long as the for profit terms of usage are not violated. For Profit terms of usage: Permission is not granted to use this book or resell/repackage this book in any manner that is to be re-sold (i.e. bookstore or student sales) without the express written permission of EPC.

For information, contact:

Ellsworth Publishing Company
P. O. Box 6727
Chandler, AZ 85246

Fax: (480) 963-4502
www.EllsworthPublishing.com
STEP-BY-STEP INSTRUCTIONS

This course is self-paced (step-by-step) and very easy for students to follow on their own. The directions were checked on Microsoft Office 2016. Each section is independent of the others and may be selected in any order. Check the Table of Contents for a complete content listing.

These sections could be used as excellent special projects in introductory computer classes such as IC5.

These easy introductions to Microsoft courses give students a good basic understanding which makes learning additional information easier. For example, use the Microsoft Excel Basics section first to acquaint students with the overall picture, then teach more about Excel. Success with these easy-to-understand sections will increase student successes in more in-depth presentations because they already know what it is, how it is used, and some applications.

MS PUBLISHER BASICS—Creating and Printing Business Cards & Newsletters (Selecting a Style, customizing information, inserting and sizing clip art, changing color schemes, printing)

MS EXCEL BASICS—Creating Simple Worksheets and Charts (Creating worksheets and charts, Auto Sum, Fill Handle to copy, Merge and Center Headings, change fonts and colors, AutoFormat, Column and Bar Charts, Enter formulas, Sort, Show Formula Version, Rename Tabs)

MS POWERPOINT—Creating Presentation Slides (Choose a Design Template, Add new slides with varying layouts, clip art, resizing clip art, animation, transition, delete slide, printing slides)

MS ACCESS BASICS—Creating and Using a Database (Create a new database, create and define tables, Query Wizard, entering Criteria, Reports)

At the end of each section are Multiple-Choice questions for tests or quizzes.

EASY GRADING—SOLUTION KEY AND STUDENT CHECK-OFF SHEET

Assignment check-off sheets are an easy method of grading and recording. Have a check-off sheet for each student. After checking their work with a solutions key, students bring it to the teacher for recording. If the assignment is acceptable (correct), the correct blank is initialed by the teacher. The teacher can initial the student’s printout. Rarely should the teacher take any assignments out of the classroom—students can put any unchecked assignments in their folder for the next class period. Grading is easy! Add up the points earned. and compare it to a grading scale (such as 90+ = A, 80 - 89 = B, 70 – 79 = C, etc.).

On the next page is an example of a check-off sheet if all lessons are used in one grading period. It is easier to grade if the points add up to 100%. If the teacher only uses a few lessons, change the total points to add up to 100%.

HOURS TO COMPLETE

Estimated hours to complete the course is from 20-26 hours of work. Some things are omitted that you find in a regular typing book like word division rules, capitalization rules, nouns and pronouns and things you get in an English class. Also not included is teaching an complete MS Word course—the MS Word concepts presented here are those that are needed to teach the lessons in this book. Teaching a full MS Word course is not the responsibility of a typing class.

Course Description
GRADE SUMMARY SHEET

STUDENT’S NAME ______________________________CLASS _____________

<table>
<thead>
<tr>
<th>LESSON</th>
<th>POINTS</th>
<th>ASSIGNMENTS (5 points each)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publisher</td>
<td>(20)</td>
<td>1____ 2____ 3____ 4____</td>
</tr>
<tr>
<td>(Approx. 2 hrs.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Excel</td>
<td>(30)</td>
<td>1____ 2____ 3____ 4____ 5____</td>
</tr>
<tr>
<td>(Approx. 3 hrs.)</td>
<td></td>
<td>6____</td>
</tr>
<tr>
<td>PowerPoint</td>
<td>(25)</td>
<td>1____ 2____ 3____ 4____ 5____</td>
</tr>
<tr>
<td>(Approx. 3 hrs.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access</td>
<td>(28)</td>
<td>1____ 2____ 3____ 4____</td>
</tr>
<tr>
<td>(Approx. 3 hrs.)</td>
<td></td>
<td>5____ 6____ 7____</td>
</tr>
</tbody>
</table>

TOTAL POINTS 103

SUGGESTED GRADING SCALE:
- 92 — 103 = A (90% of 103 points)
- 82 — 89 = B (80% of 103 points)
- 72— 79 = C
- 62 — 69 = D

FINAL GRADE FOR ASSIGNMENTS: _______

HOURS TO COMPLETE: 12—14 hours approximately
CONTENTS

EXCEL—SPREADSHEETS & CHARTS
Identify Cells ............................................ SC 3
Enter Spreadsheet Heading .................... SC 3
Enter Spreadsheet Subheading ............... SC 4
Enter Columnar Headings ...................... SC 4
Enter Row Headings ................................ SC 5
Enter Data in Spreadsheet .................... SC 5
Use Auto Sum Feature ............................ SC 6
Use Fill Handle ........................................ SC 6
Merge and Center Headings .................... SC 7
Change Fonts & Background Color ........... SC 8
Use AutoFormat ...................................... SC 9
Use Comma Function .............................. SC 10
Best Fit Column Width ......................... SC 11
Use Decrease Decimal Function ............... SC 11
Bold Entire Worksheet ......................... SC 11
Create 3-D Column Chart ....................... SC 12
Move and Resize the Chart ..................... SC 12
Create Header on Spreadsheet/Chart ... SC 14
Use All/Enter Keys to Create Two
and Three Line Col. Headings ...... SC 19
Enter Formulas in cells ............................ SC 20
Use Max, Min & Avg functions ............... SC 21
Format Fixed and Floating $ ................. SC 23
Use Borders........................................ SC 24
Show Formula Version ......................... SC 25
Use Sort Function .................................. SC 26
Rename Tabs, Change Tab order .......... SC 28
Spreadsheet & Chart Questions .......... SC 29

POWERPOINT—CREATING SLIDE PRESENTATIONS
Open a PowerPoint Doc ......................... PPT 3
Choose a Design Template ..................... PPT 3
Create a Title Slide .............................. PPT 3
Save a Presentation ............................. PPT 4
Add New Text Slide .............................. PPT 5
Add and Resize Clip Art ........................ PPT 7
Use Transparent Color .......................... PPT 10
Add Clip Art for "The End" Slide .......... PPT 10
Apply Animation .................................... PPT 12
Enhance Slide with Callout & Text ....... PPT 13
Change Animation Effects ..................... PPT 14
Change Start Effects ............................ PPT 15
Change Animation Timing ...................... PPT 16
Add Shape Effects to Clip Art ............... PPT 21
Add an Animated THE END last slide .. PPT 21
Viewing the Slide Show ......................... PPT 22
Entering Date, Page Numbers, and ..... PPT 23
Identifying Assignment
Print Several Slides Per Page ............... PPT 23
Select a Variant Color and Shade .... PPT 24
Add Transition to All Slides .................. PPT 30
Move Slides in Slide Sorter View .......... PPT 30
Delete Slides ....................................... PPT 31
Check Spelling .................................... PPT 31
PowerPoint Questions ......................... PPT 33

ACCESS—CREATING DATABASES, REPORTS, QUERIES
Create a New Database ......................... DB 3
Create a Table and Add Records ........ DB 4
Define the Fields ................................. DB 5
Best Fit the Columns ......................... DB 6
Save a Table .................................. DB 6
Modify Table Design—Delete Column .. DB 6
Modify Table Design—Add Description .. DB 6
Modify Table Design—Add Column .... DB 8
Add Records .................................. DB 9
Close the Database ............................ DB 9
Open Access and Find File ................. DB 9
Preview and Print Table Contents .... DB 10
About the Author:

Barbara G. Ellsworth taught at Mesa Community College for 46 years (claiming she started when she was five years old). Prior to 1990, Mrs. Ellsworth taught Business Machines. During that time she wrote and published over 42 workbooks for various Ten-Key and calculating machines. Mrs. Ellsworth currently has written and published five textbooks with computer programs—Ten Key Mastery, Keyboard Mastery, Keyboard Short Course, Skillbuilding Mastery, and Keyboarding For Kids (Grades 1-6), and two FREE downloadable textbooks to legal users of any EPC courses. The free downloadable textbooks are Nuts ’n’ Bolts Formatting and Introduction to Microsoft Applications (Publisher, Excel, Access, Powerpoint). Her products are found at all educational levels—K-12, College/Adult, Job Corps., and US government IRS.

Mr. and Mrs. Ellsworth are proud parents of four Eagle Scouts and one recipient of the Young Women in Excellence award.
Demonstrations for Teachers and Students

Demonstrations are available for teachers to show how to use the Teacher Manager to create course standards online, enter settings to break/prevent hunting & pecking, create classes, enter students, view student Progress and Grades online, etc. The Teacher demos also show how students enter their course, select lessons, practice, see their progress and grades, and much more. All this plus course descriptions, downloads, current syllabi, and online course information can be seen at:

www.EllsworthPublishing.com

★ **TEN KEY MASTERY** — To teach the numeric keypad with speed and accuracy. Course includes *three actual employment tests* for students to practice. To achieve employment standards, it is recommended to be a quarter or semester course.

★ **KEYBOARD MASTERY** — To teach the alpha/numeric keyboard to beginners and to those who haven’t typed in a long time and have rusty skills. The course contains 15-second to 5-minute timings that cover the basics. This course can be customized for either a semester or a quarter course.

★ **KEYBOARD SHORT COURSE** — A shortened version of KEYBOARD MASTERY. It covers the alphabetic and punctuation keys (it can be customized to include numeric or symbol keys, and longer timings). It is designed for approximately 5 - 9 weeks. The course contains mainly 15-second timings which push for speed and accuracy, and includes 30-second, 1- and 2-minute timings (longer timings can be added). This course is excellent for beginners and experienced typists who need to raise their skills quickly.

★ **SKILLBUILDING MASTERY** — Advanced Keyboarding. Covers alpha and numeric/symbol keys with 15-second to 5-minute timings designed to bring students to employable levels of speed and accuracy. It is recommended that students type approximately 32-35 wpm before taking this course.

★ **KEYBOARDING FOR KIDS** — For Grades 1 - 6. Teaches keyboarding correctly to children at a time when they are exposed to computers. The short timings and settings to break/prevent hunting & pecking help keep students’ eyes away from their fingers and keyboard. Students are rewarded with graphics of praise when they meet their goal.

★ **FREE Downloadable textbooks available to legal users of any of our courses:** Select what you want to use, download the chapters and print copies for class. Unlike most textbooks, you don’t pay for what you can’t use and we keep up with the version changes so you don’t have old textbooks around.

*Nuts ‘n’ Bolts of Formatting* text includes Using MS Word, Faxes, Memos, Business Letters, Proofreader’s Marks, Tables, Bound and Unbound Reports, Itineraries, Outlines, Job Search Skills, E-mail, etc., in easy-to-follow format with lots of illustrations and examples.

*Introduction to Microsoft Applications* text includes Publisher, Excel, PowerPoint and Access.
CREATING AND PRINTING BUSINESS CARDS
CREATING A NEWSLETTER

There are times when you will want or need business cards to hand out to business or personal contacts. They are easy to create in Microsoft Publisher and they are inexpensive to print. You can purchase the perforated forms at any office supply store. The forms can be plain, colored, or look like parchment paper. They can be made to look very professional.

Objectives

When you complete this unit, you will be able to:

- Create different styles of Business Cards
- Resize text areas
- Use Format Painter to select art
- Use Ctrl key to copy and paste
- Insert and Resize clip art
- Use the Alt & arrow keys to micro-move objects
- Save Business Card for future printings
- Print Business Cards
- Create a Newsletter from a Microsoft template
- Print only one of several pages

Open Microsoft Publisher 2016

- Click Start button, click All Apps.
- Click to select Publisher 2016.

Note: There are other ways to access Publisher 2016. Your teacher may have placed a link on your desktop.

Select a Business Card Template

- Click in the box Search for online templates and enter Business Cards. Press the Enter or Return key.
• Scroll down the pictures of Business Cards and **double click** to select and open Business cards (Soft blue design,…).

• **Click the Create button.**

• **Select the Your Name area and type your name.** Select the title area and type **Manager, #BCN-1**—which is assignment #1.

• Notice that you have a lot of extra space on the right and below the word Manager. Adjust the space by dragging the right sizing handle to the left, and the bottom sizing handle up. *Be careful to leave some space around the information—making it too small will delete some text.*

• **Select the Organization Name and enter the name of your business IN ALL CAPS if you own a company or work for a company. If you don't have or work for a business, enter the name ACE HARDWARE.**

• Select the Home tab. Select the name and change the font to 10. Bold the name.

• Select Primary Business Address and delete it.

• Select the next Address line and type 6401 S. Oracle Street (or your business information).

• Select the next Address line and type Tucson, AZ 85701. Delete the extra Address Line.

• Make up a Phone, Fax, and E-mail address. If necessary, move the left sizing handle to make room to enter the whole E-mail address.

• Select the Logo area, move the sizing handle to the right and type ACE—THE HARDWARE PLACE! (Two hyphens after the word ACE will automatically make a long dash.) **Select it and change the font to Algerian.**

• **Bold the Logo ACE—THE HARDWARE PLACE!**
**Changing Colors**

- Assume you would like a different color or deeper color for the business name and Logo at the bottom.
- Select ACE HARDWARE.
- In the **HOME** tab, click on the font color arrow and click on Dark Red.
- Click anywhere outside the selection to deselect it.

- Select the Logo **ACE—THE HARDWARE PLACE!**, and click on the font color (A) you previously chose. (Notice the color under the A shows your last selection.)
- Click outside the selection to deselect it.

- To emphasize the Logo better, select the light blue line above the Logo. (Click under the E-mail notation.)

- Click on the **FORMAT** tab. Click on the **Shape Fill arrow** and select blue, Accent 1, Lighter 60%. It makes the whole line slightly darker.

- While still selected, double click on the **Shape Outline arrow** and select a slightly darker outline of the dividing line. *If you like it, click outside the selection to leave it. If you want to check out a different look, click the Undo button and try another color or shade.*
Insert Clip Art from the Internet into your Business Card, Resize Clip Art to Fit, Reposition Clip Art, and Micro-Move Art with Alt key

- Some kind of construction clipart would add a pleasing look to your business card.
- One of the easiest ways to capture a picture from the Internet is to copy it to Paint (a program that usually comes with Microsoft applications) and select whatever part of it you want to copy to your document.

- Open your browser to get to the Internet. There are some free clipart sites. Type in the URL: classroomclipart.com and press Enter.
- Scroll down toward the bottom until you see the words KEYWORD SEARCH. Add the word “construction”. Click Go!
- Scroll down to the bottom where it shows the selection of pages that contain related clipart. Click on 2 (Page 2).
- Several options will be shown. You will see the picture of the carpenter-holding-wood-hammer. This is the one you will copy.
- Press the Print Screen key on your keyboard (often to the right of the F12 key). This copies the whole computer screen. You only want one picture. You will copy the screen capture to a program called Paint and select only what you want.
- Open the Paint program. You may click on the Start button, All Apps, and under W you will see Windows Accessories. Click the down arrow to open it up. Click on Paint.
• Hold down the **Control key** *(Ctrl under the Shift key)* and press the “V” key on the keyboard to paste what you copied when you pressed the Print Screen key.

• Click the **Select** button (box in the upper part of the Select button) in the Paint ribbon under the word **View**.

• Your mouse pointer will turn into a small circle with four lines. Move your mouse pointer to your clip art. In the upper left corner, drag your mouse pointer to the bottom right of your clip art to select it.

• Hold down the **Control Key** and press the “C” key on the keyboard to copy the image you just selected.

• Minimize the Paint screen by clicking on the minimize button “-” at the top right of your screen (to get it off your screen and out of the way but available if you need it later). If you wanted to remove it permanently you could click on the “X” button to the right.

• Click on your Business Card on the left about half way down between Manager and the blue line. Hold down the Control key and press the “V” key to paste your clip art into your business card.

• The image usually comes in too large. Click on the clip art to select it. Drag the top left sizing handle down and to your right until your image is about 1”.

• Move your pointer to the inside of the 1” clip art. The four-headed arrow means that you can move the clip art up or down, or sideways to the right or left. Drag the clip art to the area left of ACE and raise your mouse button to drop it into place.

• Sometimes it is easier to micro-move an object. Hold down your **Alt** key and use the arrows on the keyboard to **micro-move** it (move it in very small increments.)

• To make the clip art more noticeable and to denote action, tilt it slightly by dragging the center top circle to the left and down a little. When you have it the way you want it to look, lift up on your mouse button. To deselect, click anywhere outside the clip art. Be sure the right tip of the clip art doesn’t touch and delete some of the dividing line.
Changing the Color Scheme on your Cards

You may change the color scheme on your cards to blend in better with the colors in your clip art. You may select a different font scheme. Follow the directions below to change the colors.

- Click the **PAGE DESIGN** tab.
- Click the **More** button to see more colors.
- Scroll down and click on several color schemes. *Notice how the colors change on your business card.*
- Click to select a color scheme you like if you want to change it.
Use Print Preview to Check How Your Business Card Looks

- Before Printing it is a good idea to check how it looks.
- Click FILE on the Menu Bar. Click Print—Your cards show on the right.

- You see 10 business cards like the ones below.
- If necessary, go back and make any corrections you feel necessary.

Preparing Your Business Card for Printing Multiple Copies on One Page

At home or at work when you actually print your business cards, you would purchase perforated 10-to-a-page sheets. Put them into the printer; then print the number of copies you want. We will assume here that you are probably in school and will print on a plain piece of paper.

- Click on Print to print one page. Turn in to your teacher.
Saving Your Business Card to a USB Drive

- Click the Back arrow, if necessary to see the **FILE** tab.
- Click **FILE**, Save As. Click the Browse button to select the drive you want to save to.

- Scroll down to select (click on to highlight) the desired drive—In this example: USB Drive (D:). Your USB may be a different drive or identified differently.
- Click the **New Folder** button.
- When the New Folder appears, type **Homework—Publisher**, and depress the Enter key.
- Double click to open the new folder.

- Enter the File name: **BCN-1** and click the Save button.

Your name and assignment number are on each business card. Turn in Assignment BCN-1 to your teacher.
**Assignment #BCN-2, Create Your Own Business Cards**

If you are still in Microsoft Publisher 2016, click File, New, Enter Business Cards in the search box, press the Enter key. Refer to the previous instructions when necessary.

- Double click to open the Business Card style of your choice.

- Create your own business card. Include:
  - Your name, #BCN-2
  - Your title
  - A company name
  - Company Address
  - E-mail information
  - Web site information
  - Insert clip art that is related in some way to the company name. Resize and move it.

- Save your business card in the Homework—Publisher folder as #BCN-2.

---

**Be sure you have 10 cards per page. Your name is already on the assignment; print the current page.**

---

**Assignment #BCN-3, Create a Newsletter**

Newsletters are very common in clubs, churches, families and businesses to keep people informed about important information and events. Microsoft has many attractive templates to choose from. When you find the one you like, you just select the headings and type in your own headings, select the body and type in your own information and select the pictures and include your own pictures or clip art. In this assignment you will create the first page of a newsletter from The Health Shoppe about the advantages of Fish Oil, one of their newest lines.

Open Microsoft Publisher 2016. In the Online Template Search box, type `newsletter` and press the Enter key. (If you are in Microsoft Publisher 2016 ready, you can click on **FILE**, **NEW**, type Newsletter in the search box, and press the Enter key.)

- Double click on the template named `Newsletter` to open it. (Click the **Create** button if necessary.)
• It may come in too small to see clearly. The Zoom is in the bottom right of your screen. Move the Zoom lever to the right to 100%:

• Select “Newsletter Title” and enter “Effects of Fish Oil” (without the quotation marks).
• Select “Newsletter Date” and replace it with the current date. Date is at the top of the page.
• Click after “Volume 1, Issue 1.” Press the Enter key and type Your Name, #BCN-3.
• Select “Your Organization” and type your school name.
• Select each entry under “INSIDE THIS ISSUE:” and replace it with:
  Sharpening Vision (leave the leading dots and page numbers as shown)
  Healthy Skin
  Immune System
  Pregnancy & Fish Oil
  Too much Fish Oil?
  More on Moods
  Fish Oil and Long Life
• Under the “SPECIAL POINTS OF INTEREST” replace with this bulleted information:
  • Inuits rarely suffer from heart disease. (Press Enter to get another bullet.)
  • Omega-3 fatty acids are from cold water ocean fish.
  • Fish oil helps maintain brain functions.
  • Fish oil consumption tends to calm the resting heart rate.
Anthropologists (not physicians or nutritionists) first noticed that even though the Inuit, native people of Greenland, ate huge amounts of fat (from the sea animals and fish they hunted), they rarely suffered from heart disease (already in the 1950’s the major cause of death in the U.S.). Investigations by nutrition-minded researchers led to the conclusion that there was something about the nature of all that fat they were eating that was actually protecting the Inuit from the harmful effects that would be expected if the same amount of beef fat was eaten every day.

To summarize decades of research, it turns out that it is the omega-3 fatty acids (called “fish oils” because they are mostly found in cold-water ocean fish) that are the source of the “heart healthy” effects of eating ocean fish. Virtually every scientific study of these food sources published since the 1970’s has revealed yet another health benefit that can be obtained from eating fish from cold-water oceans or by dietary supplementation with their omega-3 oils. These nutrients support more than just the heart and cardiovascular system—they help maintain brain functions, help minimize skin reactions to sunlight and other inflammatory triggers and contribute to smooth flexible movement. The avalanche of reliable scientific findings supporting these conclusions provides ample motivation for making cold-water fish and fish oils the basis of your personal eating plan.

Fish oils influence your entire cardiovascular system, from how your heart beats to how much pressure your blood puts on your arteries to the health of your heart muscle itself.
Acids on Coronary Atherosclerosis. A Randomized, Double-blind, Placebo-controlled Trial.\(^7\)

**IMPORTANT NOTE—DON’T TYPE THIS:** Be sure you have typed the “)” at the end. For the superscribed 7, go back and select (highlight) the 7; click on the Home tab on the Menu Bar; click on the Superscript button.

(continuing paragraph ending with Trial\(^7\)) demonstrated that daily dietary supplementation with 2100 mg of EPA and 1050 mg of DHA prevented further growth of existing atherosclerotic plaques in the coronary arteries of men and women. Keeping your blood vessels as clear as possible helps your heart deliver all the freshly oxygenated blood your organs and tissues need.

- Open a browser, Type **heart clip art** in the Search box. Press Enter. Click on several links to find a picture you want. Find some that say “Free” or “Royalty Free”. When you find an appropriate picture, press the PrtSc key on your keyboard. Open a Paint file, Ctrl/V to paste the screen capture to Paint. Click on the Select button in the Paint Menu Bar, select the picture you want, and press Ctrl/C to copy it. Close or minimize the Paint screen.

- On Page 1 of your newsletter, Depress Ctrl/V to paste. Reduce the size of the heart clip art and place it at the top of your newsletter. Use your judgment as to where it looks best.

- Open Page 2 of your newsletter. Go back to your browser and type **medical books clip art** in the Search box. Press Enter. Press the PrtSc key on your keyboard, and follow the directions above to select and copy your clip art.

- On Page 2, click to select the existing clip art. On the Home ribbon, click on the Cut button to remove it. (Usually you can select existing clip art, Ctrl/V to paste, and it goes right in. Sometimes procedures change when you are working with templates.)

- Depress the Ctrl/V keys to paste your clip art. Move it to the top left. If you also move the left sizing handle to the left margin in line with the margins below, the words will surround the clip art and it will look like this: (see next page)
• Resize and move the clip art as necessary.

• To delete the unused or unnecessary pages of the newsletter:
  ⇒ Right click on P. 2-3 in left window, which opens a drop-down box of options
  ⇒ Click on “View Two-Page Spread” to remove check and deselected it.

• All the pages will appear singly on the left. Right click (Right double-click if necessary) on P. 3, click Delete; answer Yes to the question. Delete also pages 4-5.

Your name and assignment number are on the first page of the newsletter. Click File, Click Save as, make sure to save it in the correct Drive, Save as: Homework—Publisher folder, File name: BCN-3, Save.

Print only the first and second pages:
File, Print, Settings/Pages: 1-2, Print.
Turn assignment in to teacher.
BUSINESS CARD & NEWSLETTERS QUESTIONS

Choose the most correct answer. This is assignment #BCN-4. These questions may appear on a test.

1. Clicking on what button enables you to go back to the previous action:
   a) Undo button      b) Redo button      c) Cut button

2. What key do you depress to copy contents of your whole screen? _____
   a) Ctrl/C             b) Print Screen         c) Copy Screen

3. To micro-move objects up, use the _____ keys.
   a) Alt/Up arrow      b) Shift/Up Arrow     c) Sizing handles

4. To Change the Color Scheme on your business cards _____
   a) Format, Options, Color Schemes
   b) Insert, Designs, Color Schemes
   c) Page Design, more button

5. What is the path to Print Preview an assignment? _____
   a) Format, Page Setup, Print Preview, OK
   b) File, Print
   c) File, Print Preview

6. What do you click/move to make the screen contents larger?
   a) Format, Zoom, select %
   b) Format, Adjust, Zoom, select %
   c) Slide Zoom lever on bottom right of window

7. The path to obtain a newsletter is:
   a) Insert, File, New, Newsletters
   b) File New, Newsletters
   c) Format, New, Newsletters

8. To superscript a number, select the number and click on:
   a) Home tab, Superscript button
   b) Insert tab, Font, Superscript
   c) Format, Font, Small Numbers, Superscript
SPREADSHEETS AND CHARTS

Excel is a powerful spreadsheet program that allows users to organize data, complete calculations, graph data, and make management decisions easier.

The exercises in this chapter are to acquaint you with the fundamental features of a spreadsheet.

Objectives

When you complete this unit, you will be able to:

- Identify cells
- Enter Headings and Subheadings
- Enter Column and Row Headings
- Enter data in cells
- Use Auto Sum to Calculate Row and Column Totals
- Use the Fill Handle to Copy the Sum Command
- Merge and Center Headings
- Change Size and Style Fonts of Headings
- Change Background Color and Font Size of Headings and Subheadings
- Use AutoFormat to Format the Spreadsheet
- Change the Column Width
- Use the Comma Function
- Use the Select All cell to Bold Spreadsheet
- Create a 3-D Column and Bar Chart
- Move and Resize the Chart
- Use Alt/Enter keys in Columnar Headings
- Enter Formulas in cells
- Format Fixed and Floating $ 
- Use Max, Min & Average functions
- Use Borders
- Use the Sort function
- Show Formula Version
- Rename Tabs, and change Tab order

This is an example. Directions begin on the next page.
Open Microsoft Excel 2016

At your desktop, click on the Start icon. Click on All Apps, Under the column “E”, click to select Excel 2016. Click on Blank workbook. (Some computers may be configured differently; if so, ask your instructor what the path is. You could also enter “Excel” in the Search box.)

Identify cells

- Cells are the intersection of a column and a row.

- When identifying a cell, begin with the column letter. The cell with the rectangle is A1.

- Identify the cells with the numbers:

  1 = A1  
  2 = ___  
  3 = ___  
  4 = ___  
  5 = ___  
  6 = ___  

Notice that the toolbar has some familiar words in the Menu bar and has some familiar buttons. There are also some new buttons just for Excel functions. You will learn about the new icons as you use them in this chapter.

Enter a Heading

- In cell A1, type: $1 Thrift Store

- Notice that the words also appear in the Formula Bar.

It looks as if the words in cell A1 have spilled over into B1. They haven't really. That will be taken care of later.
• Press the Enter key, or click on the check near the formula bar.

• Click in cell B1. Notice nothing appears in the Formula Bar because nothing is in cell B1.

• Now click again in cell A1. Notice that the title appears in the Formula Bar because that's where the title is.

Enter a Subheading

• In cell A2, Enter: Candy Sold From January - March, 20-- (Enter full year, without the dashes.)

• Press the Enter key, or click the check in the Formula Bar.

Enter Columnar Headings

• In cell B3, Enter "Phoenix-1", and press the tab key.

• In C3, Enter "Phoenix-2", and press the tab key.

• In D3, Enter "Gilbert-3", and press the tab key.

• In E3, Enter "Gilbert-4", and press the tab key.

• In F3, Enter "Totals". Since this is the last column, click cell A4 because it is an empty cell. It will enter your data automatically —you could have clicked in any empty cell.
**Enter Row Headings**

- In cell A4, enter "Hershey Almonds" without the quote marks, and press the **Enter** key.
- In cell A5, enter "Kisses", and press Enter.
- In cell A6, enter "Mounds", and press Enter.
- In cell A7, enter "Snickers", and press Enter.
- In cell A8, enter "Totals", and press Enter.

**Enter Data in Spreadsheet**

- **Note:** Numbers by default (pre-programmed) are **right aligned**. As you enter data into your spreadsheet, you may sometime notice that one entry is out of line with the rest (previously changed by someone else before you). If this ever happens, click to select the cell and click on the **right align** button.

- In cells B4:E7 (the colon means "through"), enter the following data in the correct cells. You may enter the data down a column by depressing the **Enter** key, or tab across and enter the data.

- **Note:** Click in B4 to enter the number. Correction will be made later to see all of cell A4.
Use AutoSum to Calculate Column Totals Automatically

- Click in cell F4.
- Click to select the FORMULAS tab. Click on the AutoSum button arrow, and click on Σ Sum.
- It shows the suggested cells to sum (add) with a marquee around cells B4:E4 (B4 through E4).
- If these were not the cells you want to sum, you could change the highlighted area by making the sum formula to read something else like (C4:E4).

- Since B4:E4 is correct, click on the AutoSum button (this time the large Σ symbol—you have already identified that you want the sum function and it will continue until changed). You could also just press the Enter key. To correct a previous error, double click in the cell.

Use the Fill Handle to Copy the Sum Command to the Rest of the Rows

- In F4, place your pointer on the Fill Handle (the little black square); it changes to crosshairs. Hold the mouse button down while you drag the mouse down through F7.

- When you lift up the mouse button in F7, all the row totals appear! Click anywhere off the table to deselect (remove highlight).
### Use AutoSum to Calculate Row Totals Automatically

- Click in cell B8.
- Click **once on the Σ of the AutoSum button on the Formulas tab**. The marquee suggests finding the sum of B4:B7. This is correct.

![AutoSum Example](image)

- Click the **Σ AutoSum button again** to obtain the sum in F8.
- Drag the Fill Handle to the right from B8:F8. When you lift up the mouse button you will see all the totals for that row.
- Click anywhere to clear the shading in the selection.

### Merge and Center the Heading

- Click **inside** cell A1, hold the mouse button down, and drag through F1. Then let the mouse button up.
- Select the **HOME** tab, click **once on the Merge & Center button**.

![Merge & Center Example](image)

- Cells A1:F1 have been merged into one long cell, and the contents are centered automatically.

---

**Change the Size and Style Fonts of the Heading**

- With the merged A1:F1 cell still selected, on the **HOME** tab change to Arial font, 18 points (Press the Enter key after entering 18, or use to down arrow key and click on 18).

**Change the Color of the Background and Font**

- With the merged A1:F1 cell still selected, click the **Fill Color arrow** to see the color palette. Click on Dark Blue. This makes the background color dark blue.

- With the merged A1:F1 cell still selected, click the **Font Color arrow** to see the color palette. As you move your pointer on the different colors, notice the effects on your selection. Click on White.

- Click the **Bold** button.

- You now should have a Dark Blue background with White bold letters.
**Merge and Center the Subheading**

- Select cells A2:F2.
- On the HOME tab, click the Merge & Center button.

**Change the Color of the Background and Font of the Subheading**

- With the merged A2:F2 cells still selected, click the Fill Color button—notice it is still Dark Blue from the previous function.
- Click on the Font Color button—notice it is still White from the previous function—it is almost invisible because of the light background, but it is there.
- Click the Bold button.
- Your Heading and Subheading have the same background and font colors. (The lines show because the subheading is still selected—it will go away when you click somewhere else.)

**Use AutoFormat to Format the Spreadsheet**

- Select A3:F8.
- On the HOME tab, click the Format as Table arrow.
- Under the Medium heading, click to select Table Style Medium 9.

- In the Format as Table dialog box, the My table has headers box should be checked. click OK.
- Select A4:A8 in first column.
- Enter a check in the First Column box in order to format the first column differently.
- Click anywhere off the table to see the results—Column 1 is solid blue.
Use Comma and Currency Function and Decrease Decimals to 0

- Select B4:F8 (the money cells).
- On the HOME tab, click Comma Style to enter commas into the numbers. It also enters zeros at 2 decimal places.

- While B4:F8 is still selected, click on Decrease Decimal button twice to remove the .00’s.
- Click outside table to deselect.

- Select B4:F4. Hold down the Ctrl key and select B8:F8. Holding down the Control (Ctrl) key allows you to select several non-adjacent rows (rows not close to each other) at the same time.

- Click on the Currency button ($) to place $ signs in the first and last rows.
- Click on the Decrease Decimal button twice to create whole numbers. Previously you clicked on the Decrease Decimal button to delete the zeroes in B5:F7.

- Your supervisor prefers that column headings be right aligned. So, select the column headings B3:F3.

- Click on the Right Align button.
Use “Best Fit” to Increase Column Width

• It is necessary to increase the width of the column A4:A8. You can’t see all the row headings (Hershey Almonds).

• Place your pointer (a thick plus sign) on the line between columns A and B. It changes to a double headed arrow.

• Double click on the line. It will automatically adjust enough space to accommodate the longest entry in Column A. Double click between B|C, C|D, D|E, E|F, and F|G. Each of the columns will be “Best Fit” to the contents. *(It gets rid of a lot of extra space.)*

Bold the Entire Spreadsheet

• Earlier you bolded the heading and subheading, the column headings, and the numbers. Cells can be bolded individually. You can also bold the entire spreadsheet in one step by clicking on the “Select All” area to select the whole spreadsheet.

• Click the **Bold** button. Notice all the previous bolding disappeared because it had already been bolded. So click the **Bold** button again.

• Click off the worksheet area to deselect. You don’t need Column 1 heading anymore (Excel entered it to give you some extra options) so select it and press `spacebar once` (Delete key won’t work).

• Click anywhere outside the spreadsheet to deselect.
Create a 3-D Column Chart from the Spreadsheet

- Select A3:E7 to compare different stores in the same area (omit all Totals lines).

- On the Insert tab, Charts group, click the Column arrow to see the options available for column charts.

- Click on the first 3-D Column option. The screen tip that appears identifies it as a 3-D Clustered Column Chart.

- When the chart appears reflecting the data you selected on your spreadsheet (A3:E7), it will probably look similar to the one below—the chart is not placed correctly yet.

Move and Resize the Chart

- Place the mouse pointer anywhere near the corner borders until you see the words “Chart Area”.

www.EllsworthPublishing.com
• In the corner near “Chart Area”, hold down your left mouse button and drag the chart to the **top of row 10 at the left margin** under the spreadsheet. There should be one blank row (row 9).

• There are eight **sizing handles** around the Chart (see above). They are identified by 8 small circles (three on top, three on bottom, one at the left margin and one at the right margin).

• When you put your pointer on any of them, it changes to a 2-headed arrow. You can drag the margin and move it in the direction of the arrows.

• Move the **right middle** sizing handle to the right so the right margin of the chart lines up with the right margin of the spreadsheet. Move the **bottom middle** sizing handle to the bottom of row 22. Your spreadsheet and chart look like the ones below. *If you lose your sizing handles, just click anywhere in the chart area. Click off the chart to deselect.*

• Click anywhere outside the spreadsheet or chart to deselect before adding header.
Enter Header, Create Folder, Save Assignment #SC-1, Print

To enter a header:
- Select the Insert tab
- Click Header & Footer button
- Click in the left section above the worksheet under “Header”.
- Enter “Your Name” and Assignment “#SC-1”.
- Click in the Center section and enter the current date. Press the Enter key.
- Click anywhere off the spreadsheet or chart to deselect.

To Create a Folder and Save:
- Click the File button,
- Click Save As.
- Click the “Browse” button.

- Scroll to the drive you are saving to—such as the your individual USB drive. The author’s USB drive below is named CENTON USB (D:).
- Click to select your drive.
- Click on the New folder button.
- Name the new folder: Homework—Excel and press Enter.
- Double click on new folder.

- Enter the File name: #SC-1 and click the Save button.
- Double-click on the File name to open it.

To print:
- Click on the File button
- Click Print, Be sure your name, assignment # and date appear in the header. The down arrows in the column headings will not print. Click the Print button again. (If you print and just the chart is printed, you need to deselect the chart by clicking anywhere off the spreadsheet or chart, and then print again. Whatever is selected will print.)
Create the spreadsheet and chart below. The totals have been erased from the spreadsheet; you will be directed to fill in the totals. (The down arrows in each column heading do not print.) The directions follow the same sequence as in the previous exercise.

### Directions:

- Open a new Excel document. (Start, Excel 2016, Blank Workbook)
- Enter the Heading in cell A1.
- Enter the Subheading in cell A2. (Fill out the year completely.)
- Enter the Columnar Headings (Phoenix, Dallas, Los Angeles, Provo, Totals).
- Enter the Row Headings.
- Enter the data. Don’t enter the commas or $ signs yet. Be careful to enter the data correctly.

#### El Pollo Fried Chicken

Monthly Sales for December, 20--

<table>
<thead>
<tr>
<th></th>
<th>Phoenix</th>
<th>Dallas</th>
<th>Los Angeles</th>
<th>Provo</th>
<th>Totals</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chicken</td>
<td>$218,395</td>
<td>$221,613</td>
<td>$225,520</td>
<td>$229,237</td>
<td></td>
</tr>
<tr>
<td>Fries</td>
<td>111,280</td>
<td>112,319</td>
<td>115,550</td>
<td>120,220</td>
<td></td>
</tr>
<tr>
<td>Cole Slaw</td>
<td>16,590</td>
<td>17,140</td>
<td>18,050</td>
<td>18,100</td>
<td></td>
</tr>
<tr>
<td>Shakes</td>
<td>112,349</td>
<td>116,030</td>
<td>116,310</td>
<td>118,900</td>
<td></td>
</tr>
</tbody>
</table>

#### El Pollo December Sales

![Bar Chart of Monthly Sales](chart.png)
• Use AutoSum to get one Total, and use the Fill Handle to get the others. Get all the totals. (F8 should be 1887713)

• Merge and Center the Heading (A1:F1).

• Change the Font Style to Comic Sans MS, and the Font size to 18 points.

• Change the Fill Color of the Background to Dark Blue.

• Change the Font Color to White.

• Merge and Center the Subheading (A2:F2).

• Change the Fill Color of the Background to Dark Blue.

• Change the Font Color to White.

• Select the Columnar titles and right align them.

• Use AutoFormat to format the data on the spreadsheet (A3:F8): (If others have done this assignment before you, some of these steps might already be done for you.)
  ♦ Select A3:F8
  ♦ On the HOME tab, Styles toolbar, click the Format as Table button
  ♦ Under Medium, select Table Style Medium 9 (2nd row, 2nd column); In the Format As Table dialog box, a checkmark should show in My Table has Headers, click OK
  ♦ In the DESIGN tab, place a check to select First Column option
  ♦ Remove “Column 1” heading (A3, Backspace or Enter key)

• On the HOME tab, use the Comma function for all data B4:F8. Make sure the data is whole numbers. (If you see a cell with #######, that just means the numbers in the cell are too large for the cell size. When you reduce the cells to whole numbers, all will be ok.)

• Bold the entire spreadsheet.

• For the data on rows 4 and 8 only (to select both rows at once, hold down the Ctrl key as you select them), use the Currency function ($). Make sure the data is in whole numbers.

• Double click the borders at the top to increase/decrease the width (Best Fit).

Notice that there is more space after the $ sign in the Los Angeles column. That is because the column is wider than the others due to the wider column heading (Los Angeles).
• Create a 3-D chart from the spreadsheet (A3:E7).
  ♦ Select the **Insert** tab
  ♦ Select **A3:E7**
  ♦ On the Charts toolbar, click the Column **arrow**.
  ♦ Select **3-D Clustered Column**

• Move and resize the chart.
  ♦ Drag chart to the left margin between rows 10 and 25 (leave row 9 blank)
  ♦ Right margins of chart and spreadsheet should be even.

• Click anywhere off the spreadsheet and chart to deselect.

• Put your name and date in the header:
  ♦ Select **Insert** tab
  ♦ Double click on **Header and Footer** button
  ♦ Click under **Header**, on the left, and enter your name, and #SC-2.
  ♦ Click in the middle section and enter the current date.

**Note:** *Looking at this chart made the owner consider trying something else to substitute eventually for Cole slaw, such as onion rings, because cole slaw is a poor performer.*

**Save your assignment #SC-2 in the Homework—Excel folder, and print.**
Assignment#SC-3    Analyze an Accounts Receivable Balance Sheet, Use Alt/Enter keys to create two-line Headings, Enter Formulas, Format Fixed and Floating $, use Max., Min., & Average Functions, Use Borders, Sort, Create a Bar Chart, Show Formula Version, Rename tabs, Change order of tabs

You are a spreadsheet specialist in the Accounting Department of Audra’s Consignment Furniture. You are asked to summarize the monthly accounts receivable balance, create a graphic breakdown of the data (chart), and show the formula version. Follow the directions below to complete the assignment. Be sure to follow the directions to fill in the amounts—they will direct you to fill in formulas which you will show later as an assignment (don’t just copy the numbers).

Directions:

- Open an Excel document.
- Enter the Heading in cell A1.
- Enter the Subheading in cell A2. (20-- should be changed to the current year)
- Enter the Columnar Headings:
  - In cell A3 type Customer ID, and press the Tab key.
  - In cell B3 type Customer Name, and press the Tab key. (Don’t be concerned if you don’t see both words in the cell. Formatting later will take care of it.)
In cell C3 type **Beginning**, hold down the Alt key while you press the Enter key. Then type **Balance**, and press the Tab key. (By using the Alt/Enter keys, when you adjust the size of the field later both words will appear on two lines in the same cell—Beginning on top and Balance underneath. If you didn’t use the Alt/Enter keys, when you adjust the size of the field later both words would appear on the same line in the cell.)

In cell D3 type **Purchases**, and press the Tab key.

In cell E3 type **Payments**, and press the Tab key.

In cell F3 type **Credits**, and press the Tab key.

In cell G3 type **Service**, press Alt/Enter keys, type **Charge**. Press the Tab key.

In cell H3 type **New**, press Alt/Enter keys, type **Balance**. Press the Tab key.

Your unformatted headings probably look like this up to this point. All the words in the columnar titles might not show yet.

---

**Enter Data Into Spreadsheet from Audra’s Consignment Furniture, P. SC18**

- Don’t worry about the formatting yet; it might look something like this:

<table>
<thead>
<tr>
<th>Customer ID</th>
<th>Customer Name</th>
<th>Beginning Balance</th>
<th>Purchases</th>
<th>Payments</th>
<th>Credits</th>
<th>Charge</th>
<th>New Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>A161</td>
<td>Jones, Duran</td>
<td>33648.20</td>
<td>3596.50</td>
<td>6814.00</td>
<td>750.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C204</td>
<td>Hernandez, Sammy</td>
<td>9065.55</td>
<td>4335.80</td>
<td>5050.00</td>
<td>170.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>E100</td>
<td>Wang, Sheila</td>
<td>6090.00</td>
<td>975.30</td>
<td>2345.00</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>M490</td>
<td>Davis, Dusty</td>
<td>18700.75</td>
<td>5915.00</td>
<td>1978.00</td>
<td>890.40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R624</td>
<td>Thompkins, Carole</td>
<td>14095.50</td>
<td>1605.30</td>
<td>3290.00</td>
<td>235.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>U196</td>
<td>Kenney, John</td>
<td>18400.60</td>
<td>220.10</td>
<td>1375.00</td>
<td>179.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Enter Formulas Into Cells

- Follow the directions below to enter a formula in G4 to calculate the 1.85% monthly Service Charge:

  Service Charge = .0185 X (Beginning Balance – Payments – Credits)
  ⇒ Recent purchases are not included.

  - Click to select cell G4.
  - Type: =.0185*(C4-E4-F4)
    ⇒ You always begin a formula by typing “=”.  
    ⇒ The * is the Shift of the 8 key and is the multiply symbol.
  - Press the Tab key. The formula will automatically calculate in cell G4 (482.5525) and move you to the next column.

- Follow the directions below to enter a formula in cell H4 to calculate the New Balance:

  = C + D – E – F + G

  - In cell H4 type: =(C4+D4-E4-F4+G4) Formulas can be entered either in upper or lower case; it doesn’t matter.
  - Press the Tab key (or the Enter key). The formula will automatically calculate in cell H4 and enter the answer (30162.97).

Copy Formulas Using Fill Handles

- Select cells G4 and H4.
- Drag the Fill Handle (the little black box) down through Row 9:

  - After dragging the fill handle down, when you release the mouse button the formulas are copied and the answers automatically calculated:
• Calculate the Totals:
  ♦ Select cell A10
  ♦ Type the word Totals
  ♦ Tab to C10
  ♦ The AutoSum button is also located on the Home tab, far right, on Editing toolbar.
    Click on the AutoSum button twice to obtain the total (1000000.6)
  ♦ Drag the Fill Handle to the right through H10:

• After dragging the Fill Handle to the right on the Totals row, it should look like this:

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>U196</td>
<td>Kenney, Ji</td>
<td>18400.6</td>
<td>220.1</td>
<td>1375</td>
</tr>
<tr>
<td>10</td>
<td>Totals</td>
<td></td>
<td>1000000.6</td>
<td>16648</td>
<td>20852</td>
</tr>
</tbody>
</table>

Determine the Maximum, Minimum and Average values

• In cell A11, type Maximum, and press the Enter key
• In cell A12, type Minimum, and press the Enter key
• In cell A13, type Average, and press the Enter key

• Click to select cell C11
• Click on the AutoSum arrow once
• Click to select Max
  ♦ Notice that cell C11 reads: =MAX(C4:C10) The Totals column should NOT be included, so:
  ♦ Change C11 so that it reads: =MAX(C4:C9)
  ♦ Click the AutoSum button, not the arrow. The maximum, or largest, number in cells C4 through C9 (Omitting the Totals number) is 33648.2 and shows in cell C11.

• Click to select cell C12
• Click on the AutoSum arrow once
• Click to select Min
  ♦ Notice that cell C12 reads: =MIN(C4:C11)
  ♦ Change C12 so that it reads: =MIN(C4:C9)
  ♦ Click the AutoSum button once. The minimum, or smallest, number in cells C4 through C9 (Omitting the Totals and Maximum numbers) is 6090, and shows in cell C12.

• Click to select cell C13
• Click on the AutoSum arrow once
• Click to select Average
  ♦ Notice that cell C13 reads: =AVERAGE(C4:C12)
  ♦ Change C14 so that it reads: =AVERAGE(C4:C9)
  ♦ Click the AutoSum button once. The Average of cells C4 through C9 (Omitting the Totals, Maximum and Minimum numbers) is 16666.77, and shows in cell C13.
• The average (the sum of C4:C9 divided by 6 totals) is 16666.77 and shows in cell C13.

• Use the Fill Handle to copy the formulas and calculate the amounts to D11:H13:
  ♦ Select C11:C13
  ♦ Drag the Fill Handle to column H:

After dragging the Fill Handle to column H and lifting up on the mouse, the formulas were entered into all the cells and the calculations performed:

Format the Heading
♦ Merge and Center the Heading (cells A1:H1)
♦ Change the Font size to 20 points
♦ Change the Font style to Arial Black (or Cooper Black, or any style you like)
♦ Change the Fill color of the background to Dark Red
♦ Change the Font Color to White

Format the Subheading
♦ Merge and Center the Subheading (cells A2:H2)
♦ Change the Font size to 14 points
♦ Change the Font style to Arial Black (or Cooper Black, or any style you like)
♦ Change the Fill color of the background to Dark Red
♦ Change the Font Color to White

Change column widths
♦ Change the width of Col A to 11:00 by placing your pointer on the border line between column A and column B, depress the mouse button and drag your mouse to the right until 11:00 shows.
Change each of the other columns to **Best Fit** by double clicking on the border lines between each column. The columns will automatically adjust to the best fit for the **width** of the entries in the columns. The remaining border lines are shown below:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
</table>

---

**Change the heights of rows 3 and 11 to 30 points**

- Change row height by placing your pointer on the bottom border of row 3 and drag down until you see 39.75 points. Drag row 11 down to 38.50. This adds extra space between rows.

---

**Add Fixed $ Using the Currency Button**

- Select **C4:H4**. (You will change rows 4 and 10 to **Fixed** $ by using the Currency button.)

- Depress your Ctrl key and hold it down while you select **C10:H10**. Release Ctrl key and mouse.

- Click on the Currency button on the Number Toolbar:
  - The Currency style always has the $ in a fixed position on the far left of the cell, no matter how large or small the number in the cell is.

---

**Add Floating $ Using Format Cells**

- Change rows 11 through 13 to the **Floating** $. Select **C11:H13** (all of the numbers in rows 11-13).

- Right click anywhere on the selected area.

- Left click on **Format Cells** in the pop-up menu.

- Under the **Number** tab, select **Currency**. The decimal should show 2 places.

- Click OK
  - Notice that the Floating $ signs are to the immediate left of the number—not always in the same place like Fixed.
Use the Comma Function

- Format C5:H9 using Comma function:
  - Select cells C5:H9
  - Click on the Comma Style button on the Formatting Toolbar:
    ⇒ Notice that the columns lined up correctly with 2 decimal places.

Add Single and Top & Bottom Borders

- Add single bottom border:
  - Select A3:H3
  - Click the Borders arrow and select Thick Bottom Border:

- Add top and bottom border:
  - Select Totals cells A10:H10
  - Click the Borders arrow and select Top and Thick Bottom Border. It makes the Totals line stand out.
• Bold, Italicize, and center columnar headings, bold and italicize some row headings, which completes your spreadsheet:
  ♦ Select A3:H3 and apply **Bold** and *Italicics*. Click the **Center** button to center headings.
  ♦ Select A11:A13 and apply **Bold** and *Italicics*.

• Change to Landscape View (Select **Page Layout** tab, click Orientation button, Select Landscape). Portrait View is 8.5” X 11”; Landscape View is 11” X 8.5”.
• Put your name and assignment number in the Header (Insert tab, Header and Footer. In Left section under Header, enter Name and #SC-3, tab to middle section and enter the current date. Click on a blank cell to close the Header and Footer.
• Save this assignment as #SC-3 in the correct folder.
• Print Assignment SC-3. **DO NOT CLOSE THIS DOCUMENT**—you will use it below.

**Assignment#SC-4  Print the Formula Version of Your Spreadsheet**

• Depress the Ctrl key and hold it down while you depress the Tilde key (the key with the squiggly mark--to the left of the 1 key on the keyboard)
  ⇒ *You see all the formulas of your spreadsheet if you scroll to the right.*
• Change the assignment number to #SC-4. Click the left header and change it. Click somewhere else to deselect.
• On Page Layout tab, on Scale to Fit toolbar, click the arrow:
• Under Scaling, select Fit to 1 page option: Click OK.

Print assignment #SC-4 on **one** page:

**Audra’s Consignment Furniture**

<table>
<thead>
<tr>
<th>Accounts Receivable Balance--January 31, 20--</th>
<th>Service</th>
<th>Change</th>
<th>New Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beginning Balance</td>
<td>Purchases</td>
<td>Payments</td>
<td>Credits</td>
</tr>
<tr>
<td>3564.8</td>
<td>3565.5</td>
<td>6614</td>
<td>750.13</td>
</tr>
<tr>
<td>3065.55</td>
<td>4355.0</td>
<td>5050</td>
<td>170.5</td>
</tr>
<tr>
<td>8050</td>
<td>975.3</td>
<td>2345</td>
<td>0</td>
</tr>
<tr>
<td>10700.75</td>
<td>5915</td>
<td>2578</td>
<td>890.4</td>
</tr>
<tr>
<td>14095.5</td>
<td>1005.3</td>
<td>3290</td>
<td>235</td>
</tr>
<tr>
<td>16400.6</td>
<td>122.1</td>
<td>1375</td>
<td>179</td>
</tr>
<tr>
<td>SUM(C1:G1)</td>
<td>SUM(D1:G1)</td>
<td>SUM(E1:G1)</td>
<td>SUM(F1:G1)</td>
</tr>
<tr>
<td>MAX(D1:G1)</td>
<td>SUM(D1:G1)</td>
<td>MAX(E1:G1)</td>
<td>SUM(F1:G1)</td>
</tr>
<tr>
<td>MIN(D1:G1)</td>
<td>MIN(E1:G1)</td>
<td>MIN(F1:G1)</td>
<td>MIN(G1:G1)</td>
</tr>
<tr>
<td>AVERAGE(D1:G1)</td>
<td>AVERAGE(D1:G1)</td>
<td>AVERAGE(E1:G1)</td>
<td>AVERAGE(F1:G1)</td>
</tr>
</tbody>
</table>

• After Printing, depress Ctrl and Tilde keys again to return to your spreadsheet view.
**Sort in Ascending Order (Smallest to Largest)**

- Sort the New Balance column. Select **A4:H9** (Do NOT include the last Totals row).
- Select the **Data** tab.
- Click **Sort** button.

- Uncheck My data has headers.
- Under Column, Sort by, click the **arrow** and select **Column H**.
- Click OK. Notice on your spreadsheet that Column H is now sorted in Ascending order (Smallest to Largest) along with the corresponding row information.

**Remove $ in Cells, Add $ to Other Cells**

- Remove the Fixed $ in cells in Row 9 and add $ to the First Row:
  - Right click anywhere in the selection.
  - On the pop-up menu, click **Format Cells**

- In the **Format Cells** dialog box, make sure the Symbol: area indicates **None** (no $ sign).
- Click OK.

- Select cells C4:H4.
- On the **HOME** tab, click on the Currency ($) button.
Use the Chart Wizard to create a 3-D Bar Chart on a new page

- Select non-adjacent (not next to each other) ranges using the Ctrl key:
  - Select B4:B9; hold your Ctrl key down and select H4:H9
  - The customer names in B4:B9 will identify the bars
  - The data in H4:H9 will determine the length of the bars

- Select the INSERT tab.
- On the Charts toolbar, click on the Bar chart arrow.
- Click to select the Clustered Bar in 3-D chart.

- Move the left and right sizing handles until you can see all the lower dollar amounts.
- Note: If you didn’t want to see the $ in the bottom row, you could delete the $ in the first row of your spreadsheet.

Enter a Title on the Chart

- Under CHART TOOLS, click the Design tab. Click on the first layout, which enables you to enter a title on the chart.

- Select the Chart Title, and enter “Audra’s Accounts Receivables—January 31, 20—”

- Be sure chart is still selected. On the far right of the Design tab, click on Move Chart.
• Click to select **New Sheet**:
  
  • Click OK.

  ![Image](image.png)

  (Located bottom left of screen)

  • Your chart is now on Chart 1 tab, a different page than your spreadsheet. Your spreadsheet is on Sheet1.

**Add Name and Assignment #SC-5, Print Preview and Print**

• On **Insert** tab, click the Header and Footer button.  
• In the Left Section, enter your name and #SC-5. In the Center Section, enter Current Date.  
• Click anywhere off the spreadsheet to deselect.  
• To Print Preview to check how your assignment looks:
  
  ⇒ Click the **File** tab  
  ⇒ Click Print. You should be able to see the Print Preview of the assignment.

Click the Print button. Save as Assignment #SC-5 in the Homework—Excel folder.  
Look at the Bar chart and see who our biggest customers are!

**Rename the Tabs (at the bottom)**

• On the **Home** tab, **double click** the **Chart1** tab on the bottom of the spreadsheet to select the text.  
• Type **Bar Chart**, and press the Enter key.  
• Double click the **Sheet1** tab to select it. Type **Accts. Rec. 1-31-20**—, and press Enter.

**Change the Location of the Tabs**

• Place your pointer on the **Accts Rec**. tab, hold the left mouse down and drag it to the front of the Bar Chart tab. When you lift up your mouse, the Accts Rec. tab will be first.
SPREADSHEETS AND CHARTS QUESTIONS

Choose the most correct answer. This is assignment #SC-6. These questions may appear on a test.

1. The _____ calculates totals automatically.
   a) AutoFormat              b) AutoSum             c) AutoFill

2. The _____ copies the Sum command to the rest of the rows.
   a) AutoFormat              b) Fill Handle           c) AutoFill

3. Which one formats the data on the spreadsheet? _____
   a) AutoFormat             b) AutoText                c) FormatData

4. Bold the entire spreadsheet by clicking on _____.
   a) Bold All                 b) “Select All” cell, Bold       c) “Select All” cell, Format, Bold

5. The term used to explain the chart data is _____.
   a) Legend                   b) Data Range                  c) Range

6. To move a chart under the spreadsheet _____
   a) Place mouse pointer near corners; when “Chart Area” appears, move it
   b) Click on a corner handler and move the chart under the spreadsheet
   c) Click on the top right handle and move the chart under the spreadsheet

7. The Header & Footer are found on what tab? ______
   a) Home                   b) Insert                     c) Page Layout

8. When entering two-line columnar headings, use the _____ keys.
   a) Alt/Shift/Enter          b) Shift/Enter       c) Alt/Enter
SPREADSHEETS AND CHARTS QUESTIONS

9. Formulas may be copied using _____.
   a) Fill handles                    b) Sizing handles                       c) Tab key

10. The Currency style where the $ is to the immediate left of the number no matter how large
    or small the number is called a ______.
    a) Floating $                        b) Fixed $

11. The Currency style that has the $ in the same place no matter how large or small the number
    in the cell, is called a______.
    a) Floating $                       b) Fixed $

12. Best Fit refers to ______.
    a) Fit to One Page for Printing
    b) Changing Heights of Cells
    c) Changing Widths of Cells

13. To obtain the Formula Version of your spreadsheet, you need to press: ______
    a) Ctrl/Tilde                      b) Shift/Tilde                      c) Ctrl/Alt/Tilde

14. The Sort feature is accessed on which tab? ______
    a) Sort                                 b) Page Layout                   c) Data

15. Select non-adjacent ranges by depressing which key? _____
    a) Alt                                  b) Ctrl                                 c) Shift

16. If you wanted to move the chart to a new page, which option would you choose? _____
    a) Design Tab, Move Chart As object in:
    b) Layout Tab, Move Chart, Option 3
    c) Design Tab, Move Chart, New Sheet

17. To rename tabs on a two-page spreadsheet and chart, you would ______.
    a) Click on the tab, Type new name
    b) Format tab, Type new name
    c) Double click on tab, Type new name
CREATING POWERPOINT PRESENTATIONS

PowerPoint is a presentation software that creates a slide show. The slide show can have a pleasing background, printed information, tables, charts, pictures, video, sound, and animation. For almost any presentation you may give at school or at work, your effectiveness can be enhanced by making a PowerPoint presentation. Your listeners have something to watch and follow along with your presentation and it is an outline you can follow also while giving your speech.

Objectives

When you complete this unit, you will be able to:

- Open and Close a PowerPoint Document
- Choose a Design Template
- Create a Title Slide
- Save Presentations
- Add New Slides with Varying Layouts
- Add Text Boxes
- Change the Background Color
- Add and Resize Clip Art
- Add a “THE END” Last Slide with Clip Art
- Use Microsoft Snipping Tool
- Apply Animation
- Re-Order Animation
- Enhance Slide with Callout and Text
- Change Animation Effects
- Change Start Effects
- Change the Timing of Animation
- Add Shape Effects to Clip Art
- View the Slide Show
- Print Slides as Handouts
- Add Transition Effects to All Slides
- Move Slides in Slide Sorter View
- Check Spelling
- Delete Slide

This is an example. Directions begin on the next page.
Assignment #1. Starting PowerPoint, Choosing a Design Template, Creating Slide #1, Saving

- There are several ways a school can set their computers to open a PowerPoint document. If it is different from these directions, ask your teacher:
  - Click **Start** button.
  - Click on **All Apps** if necessary.
  - Scroll to the “P” section and click on **PowerPoint 2016** to open.
- Select **Blank Presentation**.

Choose a Design Template

- Select (click on) the **Design** tab on the ribbon to display several Slide Design Templates in the Themes group. Click on the **More button arrow** to see more selections. When you rest your pointer on one of the designs, a screen tip (also called a tool tip) appears below it to identify it by name. The options are listed alphabetically by name.
- Scroll to check the screen tips of the last ones and select the **Parallax** theme for your slides.

Creating a Title Slide (The First Slide)

- Click the label—**Click to add title**—located inside the title text placeholder.
- Type "**Benefits of Exercise**". Do NOT press the Enter key.
- Click the label—**Click to add subtitle**—and type **Presented by**.
Press the Enter key.

Type your first and last name. Do NOT press the Enter key.

Select the Home tab. Select (Highlight) Presented by and change font size to 24, select and change name to font size 28.

Click the Italics button.

Click anywhere outside the selected area to see the results.

To Save a Presentation on a USB Disk

Insert a USB disk into the computer (assuming that is where you want to save your work; if not, ask your teacher for directions).

Click on the File button on the PowerPoint ribbon, then Save As.

Select Browse.

Scroll down on the left list and click to select your USB Drive. In this example, it is the CENTON USB (D:) drive.

Click on the New Folder icon.

The New Folder is already selected, type “Homework—PowerPoint.”

Press Enter Key. Double click to open the new folder.

Check to see if the File name: is the name you want—#1 Benefits of Exercise. (Add #1 in front as Assignment #1.)

Click the Save button.

Print this assignment and turn it in to your teacher. Click File, Print. Then click the Print button.
Assignment #2. Add New Text Slides with a Bulleted Lists and Columns. Add and Resize Clip Art, Use Transparent Color, Add The End Slide

- On the **Home** tab, click the **New Slide arrow**. Sometimes you need to click again to see the various layout selections.

- Click to select **Title and Content**.

- **Follow directions below:**

- Click (or double click) **Click to add title** and type "**Exercises With Different Objectives**"

- Double click the first bullet and type "**Aerobic**". *(Don’t type the period.)*

- Press the **Enter** key.

- Press the **Tab** key to move the bullet to the next level to the right.

- Type "**Exercises to take in more oxygen.**"

- Press the **Enter** key. The next bullet entry will need to line up with “**Aerobic,**” not line up with “Exercises …”

- Click the **Decrease List Level button** once to move the bullet to the left (see illustration above).
Exercises With Different Objectives

- Aerobic
  - Exercises to take in more oxygen
- Muscle Strengthening
  - Exercises to build strength and large muscles
- Flexibility
  - Exercises to increase range of motion
  - For movement without stiffness or pain

- Type "Muscle Strengthening."
- Press the Enter key. Press the Tab key.
- Type “Exercises to build strength and large muscles.”
- Press the Enter key. Click the Decrease List Level button once.
- Type “Flexibility.” Press the Enter Key. Press the Tab key.
- Type “Exercises to increase range of motion.” Press the Enter key. Press the Tab key.
- Type “For movement without stiffness or pain.”
- You previously created a folder and saved to it—a path has already been created. To save your work thus far, just click on the save icon or press the Ctrl/S keys.

Slides should resemble an outline rather than a report. Lines should be short and easy to read. Remove unnecessary wording that would make sentences long. You could, for example, break up a long sentence and make it two bullets.

To Add a New Text Slide with Two Columns and Bulleted Lists (Slide #3)

- On the Home tab, click on the New Slide arrow for choices.
- Click to select the Comparison layout with a title and two columns.
• Double click to add the title: “Aerobic Exercises.”

• Click in the first box with blue lettering and type “More Oxygen.” Click in the second box with blue lettering and type “Stronger Muscles.”

• Click in the first bullet under More Oxygen and type Swimming.” Press Enter.

• Type the rest of the items in the first column; do **NOT** press the Enter key when finished with the first column. If you do, and accidentally add an extra bullet, press the Backspace key.

• Click (or double click) on the first bullet in the second column and type the remaining items.

**Add a New Text Slide**

• Click on the **New Slide arrow** and select **Two Content** layout.

• Enter the title and paragraphs to look like the example. (The larger type in boxes is just for easier reading.)

**THIS FILE WAS SAVED ONCE. Press ctrl/s to save again.**

**Add and Resize Clip Art**

There are several ways to insert clip art. One way is to use Print Screen (PrtSc key on the keyboard) which takes a screenshot of your entire screen, paste it to Paint (a program included with Microsoft office) and select the parts you want. This method is very useful to know when you want to copy something from the internet.

Two, of many, links on the Internet that give FREE clip art access are: [www.freeclipart.net](http://www.freeclipart.net) and [www.classroomclipart.com](http://www.classroomclipart.com). Most are cartoons.
Add and Resize Clip Art using Microsoft Paint

- Launch a browser—Internet Explorer, Firefox or Microsoft Edge usually.
- In the URL, enter: **www.classroomclipart.com**. Press Enter. Find and click on **Sports Clipart**.
- In the list of Subcategories, click on **Jogging Clipart**.
- When you locate the clip art on your screen that you want to use, press the **PrtSc** key (usually to the right of the F12 key) on your keyboard to capture the images.
- Open Microsoft **Paint**. (Click **Start**, rest pointer on **All Apps**, Check under the “P” column for **Paint**. It might also be under Windows Accessories.)
- Press the **Ctrl/V** (*Hold Ctrl key down while depressing the V key*) keys to paste your screen image to Paint. **Using the mouse, drag the screen image until you see your picture.**
- In the **Paint program**, click the **Select** key (not the arrow). Begin at the top left of the clip art you want and drag your mouse down toward the bottom right to select the image. If you didn’t get the image selected, click somewhere off the selection and try again.
- Press **Ctrl/C** (*Hold Ctrl key down while depressing the C key*) keys to copy your selection. Click on the “X” to **close the Paint screen. Don’t save.**
- Go back to your slide. **Be sure you don’t have anything selected.** Paste picture by pressing **Ctrl/V**. It usually will paste in the wrong place and either be too small or too large. Put your pointer on the clip art on the slide and you will see that the pointer changes to a four-headed arrow, meaning that you can move it either up and down or left or right.
- Move the clip art to the right side where you think it looks ok. Make it larger or smaller by putting your pointer on a corner sizing handle and dragging it out (larger) or toward the middle of the clip art (smaller). If necessary, you can move it again with the four-headed arrow so that it looks pleasing to the eye.
- Notice that the clip art has a white background. It would look better to have the same background as the slide—if the white part was **transparent**, you could see the slide color. Directions later will make the clip art transparent.
Add and Resize Clip Art using the Microsoft Snipping Tool

- Launch a browser—Internet Explorer, Firefox or Microsoft Edge usually.
- At the top, above the list of Subcategories, in the KEY WORDS SEARCH, click in the box and enter the words “rowing boat” and press Enter or “Go!”.
- When you locate the clip art you want to use, use your scroll bars to make it look about centered on your screen.
- Near the Start button on the bottom left of your screen you see the words “Search the web and Windows” or “Ask me anything”. Click in that area and enter the word “snip” and the words Microsoft Snipping Tool link will appear. Click anywhere on the Snipping Tool link. Then click on “New”.

![Snipping Tool Desktop app]

- Begin at the top left of the clip art you want and drag your mouse down toward the bottom right to select the image. If you didn’t get the image selected, click somewhere off the selection and try again.
- Press Ctrl/C (Hold Ctrl key down while depressing the C key) keys to copy your selection. Close the Snipping Tool and classroomclipart.com screens.
- Go back to your slide. **Click in one of the bottom corners of your slide to be sure you don’t have anything selected.** Paste picture by pressing Ctrl/V. It usually will paste in the wrong place and either be too small or too large. Put your pointer on the clip art on the slide and you will see that the pointer changes to a four-headed arrow, meaning that you can move it either up and down or left or right.
- Move the clip art where you think it looks ok. Make it larger or smaller by putting your pointer on a corner sizing handle and dragging it out (larger) or toward the middle of the clip art (smaller). If necessary, you can move it again with the four-headed arrow so that it looks pleasing to the eye. Click anywhere on the slide (preferably on the upper or lower corners where nothing is hidden) to deselect your clip art.
- Notice that this clip art has a thin white background. To make it look the same as the other clipart without any white, you can make the outer part transparent.
Add and Resize Clip Art, and use Transparent Color

- Select both clip arts by clicking on one, holding down the Ctrl key and clicking on the other one. With both clip arts selected, click to select the Format tab.

- Click the Color arrow, scroll down and click on Set Transparent Color.

- Move your pointer and you will see an arrow. Move the arrow anywhere in the clip art on any white space, and click. Notice the white background now becomes transparent—the color of the slide. (There seems to be a little white space around some clip art, ignore it.) Click anywhere on the slide, off the clipart, to deselect.

Add a “THE END” Clip Art on the Last Slide

The last slide should let people know it is the end of your presentation. To see a presentation without an ending slide is like seeing a movie and having it just quit without an ending or listening to a speaker who sits down seemingly in the middle of a speech. Here are some ending signs that were found in various places on the Internet. Use the directions on the next page to use one of them for your “The End” slide.
• Click on Slide 4 in the left Preview column to select it.

• On the Home tab, double click the New Slide arrow to add a New Slide. Select Blank.

• Go back one page to P. 10 of this section that shows all the choices for an end slide. Use scroll bars to raise clip art to about the center of your screen.

• In the Search area on the bottom left of your screen, enter “snip”. Click on the Snipping Tool/Desktop app link. Click on “New”.

• Starting in the upper left corner of your clip art, drag down diagonally to the bottom right of your clip art to select it. Try to get inside the lines surrounding it. Press the Ctrl/C key to copy it.

• Click on your new slide, #5, and press the Ctrl/V keys to paste it. Enlarge the clip art, and move it to approximately the center of your slide—Click anywhere off the clip art to deselect, move your cursor over the clip art, and you will see the 4-headed arrow. You can drag the clip art to the center of your slide.

• While clip art is still selected, click the Format tab, click the Color arrow, and click on Set Transparent color. Make clip art transparent.

• Click off the clip art to deselect it.

Save your assignment, #2 Benefits of Exercise. Click on File, Save As; Browse. Select your USB Drive. If necessary, click to open your Homework—PowerPoint folder. Be sure the File name is #2 Benefits of Exercise. Click the Save button.

Print assignment #2 Benefits of Exercise and turn it in to your teacher. Click on File, Print. Under Settings, Slides: enter 1-5, Double click on the arrow of Full Page Slides/ Print 1 Slide per Page, select 6 Slides Horizontal—Handouts (6 slides per page). Click Print.

Turn Assignment #2 in to teacher.
Assignment #3. Apply Animation, Enhance Slide with Callout and Text Animation and Effects

Animation provides movement and variety to your slide presentation and makes it more interesting for the audience.

- Click to select slide 1 in the left column.
- Click anywhere in the Title (Benefits of Exercise) to select it.
- Select the Animations tab on the ribbon. Click on the Add Animation arrow (to list your animation options).
- Under Entrance, click on the Zoom button in the third row.
- Click anywhere in the two subtitles (Presented by, Student First and Last Name).
- Click the MORE button on the Animation toolbar, click More Entrance Effects at the bottom. Under the Basic heading, click Dissolve In as the animation for the subtitles.
- Click OK at the bottom to apply.

- In the Animations tab, click the Animation Pane button (in the Advanced Animation group). Notice that an Animation Pane appeared in the upper right. Be sure the subtitles are selected. Click the Play Selected button in the top of the Animation pane to see the effects. We will change the timing later so it doesn’t come in so fast.

Save Your Work Often—File, Save as, File name: #3 Benefits of Exercise, Save

HAVE YOU BEEN SAVING YOUR WORK OFTEN? Computers are notorious for freezing, and you will lose what you entered since the previous save. If you spent a long time entering information and creating a document and the computer freezes—if you haven’t been saving, you will have learned the hard way to save OFTEN. HOW OFTEN SHOULD YOU SAVE? How long would it take to duplicate your work? After the first save of a document, (#3 Benefits of Exercise in this case) depress Ctrl/s often to save.
Enhance Slide with Callout and Text

- Click to select Slide 2 in the slide list on the left.
- On the Home tab, Drawing toolbar, click the More button arrow.
- Under Callouts at the bottom, click on the Cloud Callout.
- On the left top side where you want to begin drawing your cloud, hold your left mouse button down and drag it down and to the right—you will see that you can draw a Cloud Callout.
- Click on the cloud to select it and move it if necessary so it looks positioned like the example.

You can micro move (move in very small increments) a selection by holding down the Ctrl key and pressing the arrow keys on the keyboard. Try it. (Be sure it is selected first.)

- Click the Insert tab. In the Illustrations toolbar, click the Shapes arrow, and click to select the Text box.
- Place your drawing cursor at the upper left in the cloud. Hold the left mouse button down and drag to the lower right.
- Be sure the cursor is inside the text box. Insert the text:
  Added Benefit:
  LOSE WEIGHT!!!
- Select and bold the text. On the Home tab, Increase/Adjust the font size to fill the text box better. You might need to adjust the size of the text box and/or the cloud by dragging the sizing handles. When the text box is selected, and the cursor is a four-headed arrow, you can move the whole textbox so it is centered correctly.
• Select the text. Be sure the **Home** tab is selected. Click on the **Font color arrow** and click on White (to change the text to white).

• Click somewhere in a blank area on the slide (where nothing is selected) to deselect.

---

**To Change Animation Effects—Type and Speed**

**Changing Type:**

- Double click on Slide 1 to select it.
- Select the title (Benefits of Exercise).
- On the **ANIMATIONS** tab, in the **Animation** toolbar, click the **More** button. In the Entrance group, select **Grow & Turn**.

**Changing Speed:**

- Select Title if necessary. Double click to select the Animations tab. In the **Timing** group select a **Duration** of 1.50 seconds for the title to appear.
- Select the subtitles, Animation tab, and select **Start: On Click (some versions read “When Clicked”), Duration: 1.50** seconds, and **Delay: 1.00** seconds after the previous entry (so they don’t all come in too quickly). Click outside any selected area, like at the top or bottom of the slide to deselect.

- Click the **Play All** button to see how the animations appear.
To Change Start Effects

- To see the presentation as it is now, select the Slide Show tab and click on From Beginning. (You could also just press the F5 key on the top row of your keyboard.) Click on the mouse button to bring each line in of Slide 1.
- Press the ESC key to exit.

- Select the Animations tab. On slide 1 select the Title. Change to Start: After Previous (when the presentation begins, it will automatically continue with “After Previous” options).
- Click to select the Subtitles. Change to Start: After Previous. Be sure Duration: is 1.50.
- Click outside any selected area. Now click the F5 key. Notice how each line comes in automatically without your having to click each time.
- Press the ESC key to exit.

- Click to select Slide 2.
- Select the Title.
- Apply Grow & Turn Animation to all the rest of the titles for consistency:
  - On Animations tab, click the More button.
  - Under Entrance, click on the Grow & Turn button.
  - Change to Start: After Previous, to come in after the click from end of previous slide. (It is a good idea to click to the next slides when your speech/presentation is ready for it.)
  - Change to Duration: 1.50 (the number of seconds it takes to come in)

If you have clip art, it should support the theme of your presentation. It should usually appear on your slide after the Title. If you wait to bring it in last and then go on to the next slide, your audience won’t have enough time to read and understand its significance.

- Select the Cloud Callout by clicking on the cloud (not the text area).
Change the Timing of Animation Entrances, Making Background Transparent

After the title appears, it seems as though all the next bulleted information enters too quickly. You can add an additional pause between the title and bulleted information by increasing the Delay.

- With the cloud selected:
  - On the Animation toolbar, click the More button to see more options.
  - Under Entrance, click Bounce.
  - In Start: area enter After Previous. In Duration: area enter 1.50 seconds. In Delay: area enter 2.0 seconds to give the audience 2 seconds to comfortably read the title before the clip art appears.

- Select the words inside the cloud.
- To make the words come in with the cloud, at the same time, be sure the Entrance is Bounce (because the cloud came in with Bounce), Start: With Previous. Set Duration and Delay at same settings as cloud so they come in together.

- Click to select all the bulleted information.
- Select Fly In for the Entrance animation.
- Click the Effect Options arrow and select From Top-Left.

- Select the first bullet Aerobic. Enter Start: After Previous, Duration: 0.50, Delay: 2.00.

- Select the rest of the bulleted items manually and change to Start: With Previous so they all will come in at the same time as the Aerobic animation. Be sure the Duration and Delay is the same as for the Aerobic.
• Check the timing on your slide by clicking somewhere that won’t select anything and click **Play All** in the Animation Pane. First comes the title, then the cloud and text, then all the bulleted items from the top left.

• Click (or double click) to select Slide 3.
• Click (or double click) to select the Title area.
• Apply Animation:
  ⇒ Entrance: **Grow & Turn** (to be consistent with the other slide titles)
  ⇒ Start: **After Previous** (After clicking to continue from the previous slide, the “After Previous” begins the Title automatically on the next slide, which is this slide 3.)
  ⇒ Duration 1.50

You have decided to add clip art to Slide 3. The two images shown below were obtained from [www.classroomclipart.com](http://www.classroomclipart.com). The directions to use Microsoft Paint to obtain pictures online and paste them to your slide are summarized here: (You may use the Snipping Tool if you want to.)

1. Open a browser, enter the link above in the URL and search for free clip art similar to an item listed in **More Oxygen**. *(You could enter the word basketball, or one of the other sports listed, in the Keyword Search box. This clipart was found on page 3.)*
2. With the clip art picture on your computer screen, press the **PrtSc** (Print Screen) key on your keyboard to save it to a temporary file. **Then, close the clipart screen.**
3. Open the Microsoft **Paint** program.
4. **Ctrl/V** will paste your PrtSc contents to Paint. Move the image on your screen either up or down so your selection shows.
5. Click on the **Select** button on the ribbon.
6. Use your mouse to select the clip art you want to use.
7. **Ctrl/C** will copy your selection. After copying the clip art, minimize the Paint screen.
8. Click on your slide, **on an unselected area**, and use **Ctrl/V** to paste the clip art to your slide.
9. Resize the picture and move it as needed.
10. Notice that the background of your clip art is white. You need to make it transparent so it is the same color as the other background.
11. Select the **FORMAT** tab.
12. Click the **Color arrow**, and click on **Set Transparent Color**.
13. When you move your mouse on your slide, notice that the pointer has an arrow by it. Click that arrow inside your clipart on the white area and the background will be transparent.
14. Repeat steps 1-13 to obtain and paste appropriate clip art to the **Stronger Muscles** side.
• Click to Select the **More Oxygen** heading.
  • Apply Animation: (Click **Animations** tab)
    ⇒ Click the **More** button. Entrance: Select **Fly In**
    ⇒ Click **Effect Options** button on Animation toolbar. Select From **Top-Left**
    ⇒ **Start:** After Previous, **Duration:** 1.50 (seconds coming in), **Delay:** 0.00
    ⇒ Select the title. Click on **Animation Pane**. Click **Play From** button to see the title and More Oxygen heading animation.

• Click to select the **Left bulleted list**.
  • Apply Animation: (**ANIMATIONS** tab)
    ⇒ **More button. Entrance: Fly In**
    ⇒ Click the **Effect Options** button on Animation toolbar
      * Select From **Top-Left**
    ⇒ Change in Animation:
      * **Start:** After Previous
      * **Duration:** 1.50 (seconds coming in)
      * **Delay:** 0.00
      * Click **Play Selected** button on Animation pane. *Notice the bullets are coming in one at a time. You decide that is ok—to emphasize each one.*

• You need the basketball clipart to come in with the Basketball bullet.
  ⇒ Click on the clipart to select it
  ⇒ **More button. Entrance:** **Fly In** Animation. (Click **Effect Options**: From **Top-Left**. **Start:** With Previous **Duration:** 1.50 (to match Basketball bullet it comes in with).
  ⇒ With the clip art still selected, click the double arrows (called **Chevrons**) in the Animation Pane to expand (show) the contents.
    ⇒ Click on Picture 6 and click on the **Move Earlier arrow** until the Picture 6 is below the Basketball bullet.
    ⇒ Select the Title (Aerobic Exercises). In the Animation Pane, click on **Play From** to see your animations so far.
• Click to select **Stronger Muscles**
  ⇒ Click **More** button. Entrance: **Fly In**
  ⇒ Click the **Effect Options** button on the Animation toolbar
    * Select **From Top-Right**
  ⇒ Change in Animation:
    * **Start:** **On Click or When Clicked** (Slides are for the main purpose of presenting to an audience. Assume that you are still talking about the bulleted items under **More Oxygen** and you aren’t ready for the second list yet. The **On Click/When Clicked** option gives you the control of when to proceed.)
      * **Duration:** 1.50
      * **Delay:** 1.00

• Click to select the **Right** bulleted list.
• Apply Animation: **(ANIMATIONS)** tab
  ⇒ Click **More** button. Entrance: **Fly In**
  ⇒ Click the **Effect Options** button on the Animation toolbar
    * Select **From Top-Right**
  ⇒ **Start:** **After Previous**
    * **Duration:** 1.50
    * **Delay:** 1.00
    * Select the jogging clip art and apply the **Fly In** animation with the **Effect Option** of **From Top-Right**.

• You need the Jogging clip art to come in with the Jogging bullet.
  ⇒ If you don’t see your bulleted list for Stronger Muscles on the Animation Pane, click on the **down chevrons**:

  ⇒ Click on Picture 7 in the Animation Pane list, and click on the **Move Earlier arrow** to move it **under Jogging**. Start: **With Previous**. Duration **1.50**— to match Jogging. Delay: 1.00.
  ⇒ In the **Animation Pane**, click on **Jumping rope**. Hold down the Ctrl key and click on **Hopscotch, Soccer, Biking, and Rowing**. Add Start: **After Previous**, Duration 1.50.

  ⇒ Check your work. Select **Slide Show** tab, Select **From Beginning** button (under File tab). You could also depress the F5 key to Start From Beginning.
  ⇒ Click to advance slides
  ⇒ On Slide 2, click to show each bullet
  ⇒ On Slide 3, click to show Stronger Muscles
  ⇒ Press the keyboard **ESC key** to go back to slide view.
2. Click to select the **Title**.
3. Add animation:
   - **Entrance:** Grow & Turn
   - **Start:** After Previous
   - **Duration:** 1.50
   - **Delay:** 00.00

(1) (2) (3)

(1) Move the clip art to come in after the title:
   - Select the Rowing clip art on the slide.
   - **Entrance:** Zoom
   - Click **Effect Options**, select **Slide Center** so clip art will zoom in from the center.
   - **Start:** After Previous
   - **Duration:** 01.50
   - **Delay:** 01.50
   - Click the up arrow of **Move Earlier** until the Picture shows under the title. *(Don’t be concerned about the Picture number.)*

(2) Create a short delay after the clip art and before the first bullet enters: (Originally Duration was 1:00, but maybe 1.50 would give more time to observe the clipart.)
   - Select **Push-ups** bullet (only) from Animation Pane. Add **Delay:** 01.50

(3) Select the Jogging clip art on the slide.
   - **Entrance:** Zoom
   - Click **Effect Options**, select **Slide Center**
   - **Start:** When Clicked *(In my “lecture,” I might not be done talking about the items in the first column.)*
   - **Duration:** 01.50
   - **Delay:** 00.00 *(Clipart can come in right after the click.)*
   - Click the up arrow of Move Earlier until the Picture shows above the first bullet: Running.

   - **Select Running.**
   - **Start:** After Previous
   - **Delay:** 01.50 *(gives audience a little time after the clipart comes in to view it sufficiently before the rest comes in)*
• **Check the animation on slide 4:**
  ⇒ Click near the borders with the mouse to make sure nothing is selected.
  ⇒ Select the **Slide Show** tab.
  ⇒ Click **From Current Slide** option below the Home tab to view just slide 4 without having to view all the slides.

The Entrance, Duration and Delay are options of the creator and the effects desired—not a set rule. Sometimes after viewing the animation on a slide, you decide to make changes.

*If you duplicate an animation or clip art, or want to delete it for some other reason, right click on it in the Animation pane and a drop-down menu will appear. Left click on **Remove.***

---

**Add Shape Effects to Clip Art**

• Select the clip art on slide 4.
• Select the **Format** tab.
• In the **Picture Styles** group, click on the **More** arrow.

• Click to select the **Reflected Bevel, Black** style.

• While still selected, click on **Play From** in the Animation Pane to see if you like that selection.
Add an Animated THE END Last Slide

- Select Slide 5.
- Click to select the THE END clip art.
  - In Animations tab, Entrance: Spinner (click MORE button for more options, More Entrance Effects at bottom, click on Spinner).
  - Click OK

- Start: After Previous
- Duration: 2.00
- Delay: 00.50

- Click Play From in Animation Pane to check animation.

Viewing the Slide Show

- Select the SLIDE SHOW tab and click on the From Beginning button. Click after each slide to go to the next one. (Remember, you will need to click twice on Slide 3.) View the whole presentation.

- You also could click on the Slide Show icon or press the F5 key on the keyboard and it would have the same effect as clicking the From Beginning button.

- Depress the Esc key to get out of Slide Show mode.

NOTE: If you want to add page numbers or dates or something else to your slides, click on the ? and enter your request for additional information.

If there are no changes to be made, save your work to your Homework—PowerPoint file as Assignment #3. Your teacher may want to see your presentation.
Entering Date, Page Numbers and Identifying Assignment

- Add a Header & Footer to your printout:
  - On the INSERT tab, click the **Header & Footer** button.
  - Click to select the **Notes and Handouts** tab.
  - Click on the box for **Date and Time** and the circle for **Update automatically**. Click on the boxes for Page number and Header. In the header box, enter your **first and last name, and #3 Benefits of Exercise**
  - Click the button **Apply to All**.

Printing the Slides

- Click the **FILE** tab. Click **Print**.
- Click the arrow on **Full Page Slides**
- Click to select **3 Slides** (it will print 3 slides on two pages because you have 6 slides). This option is helpful to your audience when you want to pass out a copy of your slides with lines so they can add notes from your presentation.
- Click **Print button**.

Turn Assignment #3, two pages, in to your teacher.
Assignment #PPT-4  Create a Presentation with Clip Art, Add Text Box & Text, Animation, Transition, Move Slides in Slide Sorter View, Check Spelling, and Delete Slide

Follow the directions in the previous pages when necessary to complete this assignment.

Start PowerPoint 2016. If you are already in PowerPoint, open a new PowerPoint file by clicking the FILE tab, New, Scroll down to search for and select Droplet Style, Click Create.

Select a Variant (color, Shade) and create the first slide

- Click the Design tab, Click Variants arrow and select the purple Variant.
- Click to select the Title and enter WHAT TO DO FOR COLDs AND FLU (it will be on two lines).
- Select the subtitle and enter: by Your First and Last Name

Presented by: Your first and last name

Save the Presentation

- FILE tab, Click to select SaveAs.
- Click on Browse.
- Scroll to select your USB drive (unless otherwise directed), double click the Homework—PowerPoint folder.
- File name: #4 WHAT TO DO FOR COLDs AND FLU (The first line of a document usually appears; add the #4.)
- Click SAVE. Since you created the path, you can save in the future by depressing Ctrl/S if you want to.

Add a New Slide, Title and Content Layout

- On the HOME tab, click the New Slide button arrow and select Title and Content.
- Add this information: (On this style, everything goes in as all caps automatically!)
  
  Title: KNOW WHEN TO CALL YOUR DOCTOR
  
  Bulleted Information:
  
  - Your symptoms get worse
  - Your symptoms last a long time
  - You develop more serious symptoms: (Press Enter, and press the tab key to indent.)
    - Stomach sickness
    - Vomiting
    - High Fever
    - Shaking Chills
    - Chest Pain
    - Coughing with yellow-green mucus
Add Clip Art
- Click on the inside corner of your slide to deselect anything. Add clip art of a doctor to the right of the bulleted items. Resize larger. (This clip art was found in www.classroomclipart.com, enter doctor in Keyword Search.)
- With clip art selected, click on FORMAT tab, Color arrow, Set Transparent color, and click somewhere inside the clip art to make background transparent.

Add a New Slide, Title and Content Layout
Title: TRY TO AVOID CATCHING A COLD
- Wash your hands often
- Avoid people with colds
- Throw away used tissues
- Use germ-killing disinfectant
- Don’t touch nose, eyes, or mouth
- Add a clip art showing one of the bulleted items. (Keyword Search: washing hands) Get one with a white background so it can be transparent.
- Resize clip art larger.
- Make background transparent.

Add a New Slide, Comparison Layout
- Enter Title and Symptoms and Medicines headings.
- Enter bulleted items.
- Select bulleted items and change to numbered items. On the Home tab, click on:

<table>
<thead>
<tr>
<th>CHOOSING THE RIGHT MEDICINES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SYMPTOMS</strong></td>
</tr>
<tr>
<td>1. UNCLOG A STUFFY NOSE</td>
</tr>
<tr>
<td>2. QUIET A COUGH</td>
</tr>
<tr>
<td>3. LOOSEN MUCUS</td>
</tr>
<tr>
<td>4. STOP RUNNY NOSE AND SNEEZING</td>
</tr>
<tr>
<td>5. EASE FEVER, HEADACHES, MINOR ACHES AND PAINS</td>
</tr>
</tbody>
</table>

Add a New Slide, Title and Content Layout
- Title: WARNING!
- Make paragraphs at the right into two bulleted items. Bold the word “NOT”.
- Add an appropriate clip art some place that reflects danger. (Good site: www.compliancesigns.com/ppc/danger) Make background transparent.

WARNING!
Do NOT give aspirin or other “salicylates” in cold medicines to children or teenagers with symptoms of a cold or flu.
Young people can get sick or die from a rare disease called Reye syndrome if they take salicylates while experiencing flu or cold symptoms.
• Save to **Homework—PowerPoint**. You could click on the save icon in top left of your window, or Ctrl/S.

**Add a New Slide, Select Blank Layout, Use Text Tool**

- Add a new slide, **Blank** layout.
- On the **INSERT** tab, click on the **Text Box**. Make sure the new slide is added at the end.
- In about the middle of the slide, hold the left mouse button down and drag it to the right about 2 inches and down about an inch.
- Type the words: **THE END** (in all capital letters).
- Select and Bold the words: **THE END**
- Change Font size to 60 or more.
- On the **Home** tab, click the **Quick Styles** button and select **Subtle Effect—Purple Accent 3**.

**Add Animation to Slides**

- On Slide 6 the **THE END** words are still selected. You might as well add animation. We’ll add animation to the rest of the slides later
- Adjust the sizing handles to be closer to the words, and center it.
- Select the **ANIMATIONS** tab.
- Select **ZOOM** animation
  ⇒ Start: After Previous
  ⇒ Duration: 01.50
  ⇒ Delay: 00.00
• Click to select Slide 1.
• Click to select the Title.

• Select **Zoom** animation
  ⇒ Start: After Previous (Later, you will be adding Transition to your slides and will want your slide show to begin automatically after the first transition.)
  ⇒ Duration: 01.50
  ⇒ Delay: 00.00

• Click to select the **Subtitle**.
• Select **Float In** animation.
  ⇒ Click Effect Options and select **Float Down**.
  ⇒ Start: After Previous
  ⇒ Duration: 01.50
  ⇒ Delay: 02.00 (to give the audience time enough to read entire Heading)

• Click to select the **Title**, and click the **Play From** button in the Animation Pane to check your animation so far.

---

• Click to select Slide 2.
• Click to select the **Title**.

• Select **Zoom** animation to be consistent.
  ⇒ Start: After Previous
  ⇒ Duration: 01.50
  ⇒ Delay: 00.00

• Click to select the clip art. *(It is a good idea to animate your clip art right after a title so it appears first before bullets. Clip art is supposed to support the theme of your slide; if you wait until the end before going to the next slide, your audience won’t see it long enough to know of its significance or meaning to your slide.)*
• Select **Float In** animation.
  ⇒ Click Effect Options and select **Float Down**.
  ⇒ Start: After Previous
  ⇒ Duration: 01.50
  ⇒ Delay: 01.50

• Click to select the left list of symptoms.
• Select **Random Bars** animation.
  ⇒ Click Effect Options and select **All at Once (They can all come in at the same time and people can read at their own rate).**
  ⇒ Start: After Previous
  ⇒ Duration: 01.00
  ⇒ Delay: 01.50

• Click to select the **Title**, and click the **Play From** button in the Animation Pane to check your animation so far.
• Click to select Slide 3.
• Click to select the **Title**.
• Select **Zoom** animation to be consistent.
  ⇒ Start: After Previous
  ⇒ Duration: 01.50
  ⇒ Delay: 00.00
• Click to select the clip art.
• Select **Grow & Turn** animation.
  ⇒ Start: After Previous
  ⇒ Duration: 01.50
  ⇒ Delay: 01.50
• Click to select the left list of actions.
• Select **Random Bars** animation.
  ⇒ Click Effect Options and select **All at Once**.
  ⇒ Start: After Previous
  ⇒ Duration: 01.00
  ⇒ Delay: 01.50
• Select the **Title**, and click the **Play From** button in the Animation Pane.

---

• Click to select Slide 4.
• Click to select the **Title**.
• Select **Zoom** animation to be consistent.
  ⇒ Start: After Previous
  ⇒ Duration: 01.50
  ⇒ Delay: 00.00
• Click to select the **left list** of actions. (We aren’t animating the subtitles this time.)
• Select **Random Bars** animation.
  ⇒ Click Effect Options and select **All at Once**
  ⇒ Start: After Previous
  ⇒ Duration: 01.50
  ⇒ Delay: 01.50
• Click to select the **right list** of actions.
• Select **Random Bars** animation.
  ⇒ Click Effect Options and select **All at Once**
  ⇒ Start: On click (so you have some control over when to begin talking about Medicines)
  ⇒ Duration: 01.50
  ⇒ Delay: 01.50
Select the **Title**, and click the **Play From** button in the Animation Pane.

- Click to select Slide 5.
- Click to select the **Title**.
- Select **Zoom** animation to be consistent.
  - Start: After Previous
  - Duration: 01.50
  - Delay: 00.00
- Click to select the clip art. (Remember? We want it to come in after the title so it is on the slide longer.)
- Select **Grow & Turn** animation.
  - Start: After Previous
  - Duration: 01.50
  - Delay: 01.50
- Select the first paragraph with your mouse.
- Select **Random Bars** animation.
  - Start: After Previous
  - Duration: 01.00
  - Delay: 01.50
- Select the second paragraph with your mouse.
- Select **Random Bars** animation.
  - Start: After Previous
  - Duration: 01.00
  - Delay: 03.00
- Select the **Title**, and click the **Play From** button in the Animation Pane.

CHECK YOUR WHOLE PRESENTATION BY CLICKING ON THE F5 KEY ON YOUR KEYBOARD.

PRESS THE ESC KEY TO EXIT.
Add Transition to All Slides

Transition is the way slides are introduced in your presentation. Instead of just appearing, slides might fade in or wipe in. Follow the directions below.

- Select slide 1.
- Select the TRANSITIONS tab.
- Click the More button to see all the transitions.
- Click on each transition to see the effect it would have on your slide. Click to select the transition of your choice. When you have clicked on the transition you like, click the Apply To All button.
- Duration: 1.50
- Click F5 key to view transition effect and entire slide show.
- Click to advance to the next slide. (You will also need to click on slide 4 to bring in the right list—not coming in automatically gives you a little more time to discuss symptoms and answer questions from the audience.)
- Depress the ESC key on the keyboard to exit.

Move Slides in Slide Sorter View

Slide Sorter View allows you to see all your slides at once. You may decide that slides should be in a different order. You can easily change the order.

- Select the VIEW tab on the ribbon.
- Click to select the Slide Sorter.
Click on slide 3 and drag it to the left with your left mouse button to between slides 1 and 2. Life up on your mouse button. This is the order now that will appear in the slide presentation.

Deleting an Unwanted Slide

- You can delete a slide in the Slide Sorter View or in the Normal View with miniature slides numbered and showing down the left side of your screen. When you right click on a slide, a dialog box with several options appears. One option is “Delete Slide”.

Check Spelling

- If necessary, click the Normal button to return to the Normal view and see slides in original form.
- Select slide 1 (if not already selected) so spell check can start from slide 1 and check all slides.
- Select the REVIEW tab.
- In the Proofing group, click the Spelling button.
• If Spell Check finds an error, it will highlight it on your slide and you will see the misspelling and the recommended spelling on the right slide of your window. Make any necessary corrections (click the Home tab and select the slide you need to change).

• When there are no errors, you get a Spell check complete notice.

View the Slide Show

• There are several ways to view your slide show. Click to select the SLIDE SHOW tab and review lots of options. Probably the easiest method is to click on the F5 icon.
• Press the Spacebar or Enter key to advance from slide to slide.
• Press the ESC key after the last slide.

Print the Slides

• Select the Insert tab. Click to select Header & Footer. Select the Notes and Handouts tab. Include (check) Date and time, Update automatically, Page Number, Header—Student First and Last Name, #4 What to do for colds and flu. Click Apply to All button.
• Save this assignment.
• Click the FILE tab.
• Click Print.
• Click the arrow on Full Page Slides
• Click to select 6 Slides Vertical (1,2,3 down in first column, 4,5,6 down in second column)
• Click Print button.

Turn Assignment #4 in to your teacher.
POWERPOINT PRESENTATION QUESTIONS

Choose the most correct answer. These questions may appear on a test. This is assignment #PPT-5.

1. The ________ tab accesses the design templates.
   A) Home   B) Design   C) Template

2. The first slide is called a ______?
   A) Name slide            B) Sub-Title slide              C) Title slide

3. To add a new text slide with a bulleted list, click on the New Slide button on the ______.
   A) Home tab   B) Layout tab   C) Insert

4. Click the ______ once to move the bulleted information to the left.
   A) Increase List Level button        B) Decrease List Level button        c) Control tab

5. Changing the background of a clip art to Transparent on a slide is done on what tab? ____.
   A) Design      B) Format         C) Background

6. What is a path to include clip art into your presentation, such as The End? ______
   A) Online, find image, PrtSc key, Word
   B) Insert, Clip Art, press Enter
   C) Online, find image, PrtSc key, Paint

7. Movement on a slide (like Fade, Zoom, etc.) is called? ______
   A) Transition   B) Animation

8. What is the rule for how often you should save your work? ______
   A) Duplication time  B) Every 30 minutes     C) Every 45 minutes

9. You can micro move (move in very small increments) a selection by holding down what keys on the keyboard? ______
   A) Alt/arrow   B) Ctrl/arrow        C) Shift/arrow

10. To get out of Slide Show mode, back to Slide View, press the ______ .
    A) Esc key    B) F1 key        C) File, Close
11. On the Print menu, select ______ to print six slides to a page in this order. 1 2
                                           3 4
                                           5 6
   A) Vertical   B) Horizontal   C) Full Page Slides

12. If you are already in PowerPoint and want to start another new presentation, you can click on the ________ .
   A) File Button, New, Create
   B) New Presentation Button
   C) File Button, Create

13. The way slides are introduced in your presentation is called _____.
    A) Transition   B) Animation

14. What view allows you to see all your slides at once?_______
    A) Slide View   B) Sorter View   C) Slide Sorter View
Access

Creating and Using A Database
CREATING AND USING A DATABASE

In your personal life you may want to keep a variety of records such as names, addresses, and telephone numbers of friends and business associates, records of investments, records of expenses for tax purposes. Businesses must also keep records of customers’ names, addresses, amount paid, amount due, work outstanding, etc. A database is a collection of data organized in a way that you can access it quickly and easily.

In this chapter you will be introduced to creating a database, querying information, and creating a report.

Objectives

When you complete this unit, you will be able to:

- Create a New Database
- Create Tables & Define the Fields
- Add Records to the Tables
- Preview and Print the Contents of a Table
- Close and Save a Table
- Add and Delete Columns in a Table
- Rename Columnar Headings
- Use the Simple Query Wizard to create a Query (to Obtain Information)
- Use Criteria to Restrict Query Information
- Use the Sort Ascending Function
- Adjust Column Margins Manually
- Create and Print a Report
- Close the Database
Starting Access

- There are several ways a school can set their computers to open an access document. If it is different from these directions, ask your teacher:
  - Click Start, Click on **All Apps**
  - Under **A** category, click on **Access 2016**
  - **IF YOU HAVE WINDOWS 8, and Access 2013 is on your desktop, you can just click on it.**

Creating a New Database and Saving

- To save your work, insert your USB Drive into your computer, or save on the hard drive as directed by your teacher.

- In Access, click on **Blank database**.

- On the Blank database window, enter the File Name **Owens and Sons** and double click the folder icon to locate where to save (assuming not the C: drive).

- (1) Scroll to the drive where you want to save (CENTON USB (D:) in this example), and click to select it.
  (2) Click on the New Folder button.
  (3) Type the new folder as **Homework—Access**, and press the Enter key.
Double click on the Homework—Access folder to open it. As yet there isn’t anything in it.

Add File name: Owens and Sons

Click OK.

After clicking Ok, notice that the File Name appears (with an extension added by Microsoft), and under it is the location where it is saved (D:\Homework—Access).

Click Create.

**Creating a Table and Add Records**

An access database consists of a collection of tables. After you have created the database, you need to create several tables within it which contain important information. The Field Names are the column headings, the Data Type is usually Text or Currency, and the Field Size usually varies. Every table must have one Primary Key—different and unique to each customer. It is assumed that the ID is usually different for each customer and so will be the Primary Key.

If necessary, maximize the screen by double clicking anywhere in the free space in the Title bar (first line on top).

Click on the Create tab. Click on Table.

On the table you created, click in the first cell (under ID). Click the arrow for Data Type and select Short Text. Change the Field Size from 255 to 4.
DB 5 Creating & Using a Database

Define the Fields—Rename the Columnar Headings

• In the cell under the ID and enter **BL23**. Data Type should be Short Text, and changing the Field Size to 4 (so no more than 4 digits can be entered) will prevent someone from accidentally adding too many digits.

• **Click in the next cell (Click to Add—changes to Field1 after entering it) and enter Bland & Sons, and press the Enter key.** Enter the data above for Fields 1-5 only, and check to see the Data Type is **Short Text**. Don’t worry now if a Field seems too small and you can’t see all the name.

• For **Field 6**, click on the title “Click to Add” and a selection of actions will appear. Click to Select **Currency**. The Currency data type will automatically enter the $ sign and 2 decimal places to **whole numbers**; you still have to enter decimals to separate dollars from cents.

• Click the cell under Field6 and enter the amount for Field6 in the table above. **Don’t add the cents because this is a whole number and it will automatically add two 00’s.**

• For Field 7, click on the title “Click to Add” and from the selection click on Currency.

• Click the cell under Field7 and enter the amount for Field7 in the table above. Since this is a whole number amount; don’t add the two 00’s. **Press the Enter Key after Field7 to put the cursor in the ID column of the next row.**

• Enter the amounts into the rest of the rows. After the first row, you can tab to the next fields and next rows. **Remember, you must enter the decimal when you enter cents amounts; you do not enter the 00’s when the amount is a whole number without cents.**

Define the Fields—Rename the Columnar Headings

• Right click the first heading (ID) and click on **Rename Field**.

• The ID heading is selected; type **Customer Number**.

• Right click on each of the other fields, select Rename Field, and rename the column headings as they are shown below. **You will Best Fit the columns on the next page to see all columnar headings and data.**

| Field1 = Customer Names | Field4 = States | Field7 = Current Due |
| Field2 = Addresses | Field5 = Zip Codes |
| Field3 = Cities | Field6 = Amounts Paid |
Best Fit the Columnar Headings

- Look at your table. Some of your columns weren’t wide enough when you entered the data (especially the Customer Name column) and some columns might be too wide. “Best Fit” each column—place your pointer on the border lines between each field heading and double click when you see a double-headed arrow. This will remove or add needed space.

![Table Example]

Saving a Table

It’s a good idea to save often. How often? If there is a surge in electricity and your computer freezes up, you will lose whatever has not been saved (and sometimes a computer will freeze for no apparent reason). Best to play it safe and save often and prevent headaches later.

- On the Quick Access Toolbar, click the Save icon.

- In the Save As dialog box, for the Table Name: enter Customer—your last name, #DB-1. Putting your last name and assignment number after the table name will help identify your printouts for your teacher.
- Click OK
- Notice your Table name changed. The name of the table is “Customer”.

Modifying the Design of a Table—Deleting a Column & Adding a Description

When you create a table, you may later find that you would like to add a new column, delete a column, change the order of the fields within a table, add a description. It is easier to make changes in Design view.
• Click the **Home** tab. In the **Views** group, click the View button arrow and select the **Design View**.

![Design View](image)

- Microsoft Access automatically assigns the Primary Key to the first row of a table—the Customer Number row in this table. Notice the little key in the top Row Selector box. The Primary Key is the field that uniquely identifies a record in a table. No two customers will have the same Customer Number. Customers could have the same name, especially if you do business in several states, but you will enter a different Customer Number for each.

![Customer Table](image)

- Owens & Sons is a small, family owned construction company that does business within the state only. The State field is not needed. Right click in the Row Selector box by the States Field Name to bring up a menu of actions, and click the **Delete Rows** button.

- Click Yes to question box asking if you want to permanently delete the file.
• Click in the Description column for the Zip Codes field, enter “Five-character Zip Code” (without the quote marks of course).

• In the Description column for the Current Due field, enter “Outstanding Balance”.

• Select the row for Zip Codes by clicking in the little box to the left of the Field Name. In the Field Properties section, select the entry for Field Size and change it to 5 (no more than 5 characters can be entered as a zip code).

• Click the View Button to return to the Datasheet view. Click Yes, and Yes again to the two saving Dialog boxes that appear.

Modifying Table Design—Adding a Column.

Owens & Sons has decided they need a row for Phone Numbers:

• Right click on the heading of the Address Row.

• Click on Insert Field. A blank column (Field1) will appear to the left.

• Right click on Field 1 cell, left click on Rename Field, and rename Field1 as Phone Numbers. Press the Enter key.

• Double click on the right border of the Phone Numbers cell to Best Fit the letters.

• Click Save on the Quick Access Toolbar. Remember to save often.
Enter the phone numbers for each customer. Press the down arrow on your keyboard to advance down to the next row.

**Close Access**

- Click the **Close** button. Click **yes** to save.

**Open Access and Find File**

- In Windows 7, click on **Start**. Rest your pointer on **All Programs**. Double click on **Accessories**. Click on **Windows Explorer**. (This is a common method; there are other ways. You could also right click on Start, and left click on **Open Windows Explorer**.)

- In Windows 8 and 10, click on the **Start** icon and click on **File Explorer**.

- Click on the USB drive; in this example it is called **CENTON USB (D:)**.

- Click on the **half diamond** to the left of the USB drive to **expand** its contents so we can see the folders.

- Click on the **Homework—Access** folder to expose the contents.

- Double click on the **Owens and Sons** file to open it.
Click the **Enable Content** button. If you forget this step, there will be many of your Access assignments in school that will not turn out correctly even if you have done them right.

Double click your **Customer table** to open it.

---

### Print Preview, Change to Landscape view, Print

- Click on the **FILE** button. Click on **Print**.
- Click on **Print Preview**. Notice that not all the columns in your table are showing. The last two columns are Amounts Paid and Current Due. **Portrait size is too small (8 1/2” x 11”).**
- Click on the Landscape button. **(Paper size for Landscape is 11” wide x 8 1/2” high.)** It is still not showing all the columns. Click on the Margins arrow, and click to select **Wide**. It will show all the columns.

**Note:** If you wanted to increase/decrease the document size in Print Preview, put your mouse pointer in the table area. It changes to a magnifying glass mouse pointer. Click once or twice to see the change in size.

Click the **Print button** on the **Print Preview toolbar**. Click **OK**. Click the Close **Print Preview button**. Your name and assignment number are on the printout. Turn this in to your teacher as Assignment #DB-1.

---

### Assignment #DB-2  Adjust Column Margins Manually, Create and Print a Report

A **Report** is a database object that displays fields and records from a table in a professional-looking way. They usually have nice headers and often are automatically dated.
• If your Customer table is not showing: (If it is, skip this.)
  ⇒ it might be hidden in the Navigation Pane. Open the Navigation Pane by clicking on the double chevrons
  ⇒ In this case, you would open your table by double clicking the table name.

• Click the Create tab.

• In the Reports group, click Report.

Mr. Owens, the owner of the business, wants a list of his clients and the Current Amount Due. Since you want this information to look more professional than a table, you want to create a Report.

• Right click anywhere in the columns in the Report that you don’t want to include. This brings up another menu—click on Delete Column. Delete these columns:
  Addresses
  Cities
  Zip Codes
  Amounts Paid

This is what your report looks like after deleting the columns and making the space between columns shorter. (Directions are given later to make the Current Due total more legible.)

Click on the Customer Names title.
Place your pointer on the right margin of that cell and it turns into a double-headed arrow. Drag it to the left, being sure all of the column title and any information in the cells show. Click on the Phone Numbers title and drag it to the left; do the same to the Current Due title (you won’t change much).
Assignment #DB-3   Using Criteria in a Query to Restrict Information, Using the Sort Function

Queries are simply questions, the answers to which are in the database. For example, How many customers owe us more than $10,000?

• Move the bottom margin of the Total cell down so the total amount can be more easily seen. Click on the bottom margin of cell until the double-headed arrow appears and drag it down just enough that the whole Current Due total is clearly seen.

• Double click in the report name and change your assignment number to #DB-2.

Not sure how To save: Click File, Save As, Click Save Object As, Click Save As button. When the Save As dialog box appears, change the Assignment name to #DB-2 and click OK. It might save automatically when clicking on Close button. Turn into teacher.

Click the FILE Button. Select Print, Print Preview to see what it looks like. It will print without the cell lines showing. Click the Print button on the Print Preview ribbon, click OK. Click the Close Print Preview button. Click the close button. Click No to change the table, but click Yes to save #DB-2, Click OK.

Assignment #DB-3   Using Criteria in a Query to Restrict Information, Using the Sort Function

Queries are simply questions, the answers to which are in the database. For example, How many customers owe us more than $10,000?

• Open Owens and Sons database. (If opening the database anew, click Start icon, click File Explorer. Under Recent Files, double click on the Owens and Sons database.)

• Double click on the Customer Table (under Tables) to open in datasheet view.

• Click the CREATE tab.

• In the Queries group, click the Query Design button.
• On the Show Table dialog box, select the Customer table (#DB-1), click Add.

• Click Close.

• Be sure your screen is maximized—it should fill the whole screen. You should see two small squares.

• Place your pointer in the middle of the bottom border of your Customer Table list until you see a vertical two-headed arrow.

• Hold your left mouse button down, and drag the bottom border down until all fields are visible.

• Double click:
  Customer Number
  Customer Names
  Phone Numbers
  Current Due

• The fields appear in that order at the bottom of your window.
Mr. Owens wants to know who owes him more than $10,000. To query this information:

- Click the **Sort** cell in the **Current Due** column. Click the arrow and select **Ascending**. (Current due amounts will be listed smallest amount due to greatest amount due.)

- In the Criteria row, in the Current Due column, of the grid enter >=10000 (greater than or equal to 10000—no $ or commas).

  *The > symbol is the Shift/period keys. <= would be less than or equal to.*

### Run a Query

- Click the **Run** button in the Results group.

There are three customers of Owens & Sons that have a Current Due balance of $10,000 or more. Mr. Owens also wanted the phone numbers so the secretary could call them and remind them about payment.

- Save by holding down the Ctrl key on the keyboard and depressing the S key. Save as Customer Query—Your name, #DB-3. Click OK. Click the FILE button, click Print, click Print Preview. Close the Print Preview. Click File, Print, Print. Click OK. It will print with your name and assignment number. Turn this assignment in to your teacher.

Close Access.
Assignment #DB-4  Creating a Database, Printing a Table

Denver Drivers Training Company requires payment for driving lessons before each lesson. Follow the directions in the previous pages to complete this assignment. The directions for this assignment are below the illustrations.

- Begin Access 2016. Create a new database called Denver Drivers Training and save it in your Homework—Access folder. (Open Access 2016, Select Blank database, Enter File Name as Denver Drivers Training, Click small folder button to browse for a location to put your database, Select your USB Drive, Click OK. Click Create button.

- Click View icon and select Design View. Press CTRL/S (Short cut keys) to save table as Client Table — Your last name, #DB-4. Click OK.

- In Design View, add these Field Names and Descriptions. Disregard ID field—it will be filled in automatically. All Data Types should be Short Text, except Amount Paid which should be Currency.

- Click View,Datasheet view. Save the table when asked.

- Enter the following data into the table. Best Fit each column after all data is entered. (Ignore ID column—it will be filled in automatically.)

- Press CTRL/S to save the table.

Click FILE, Print, Print Preview. Not all the columns show in Portrait view, so click on Landscape View. (Some printers differ a little. In the Print Preview, if even in Landscape View it doesn’t show all the columns, select Two Pages on the ribbon.) Click the Print icon on the ribbon (under File), click OK. Close Print Preview. Close Access. Turn this assignment in as #DB-4.
Assignment #DB-5  Creating and Printing a Report

Denver Drivers Training Company would like a report of the current customers in the Client table. The manager is going to send them a Thank You card and ask for referrals. He does not want the Client No, Amount Pd or Trainer No fields in the report.

- Open Access 2016. On left side, click to open Denver Drivers Training Co. Click Enable Content to be able to edit/make changes.
- Under Tables, double click to open the Client Table of Denver Drivers Training Company.
- Select the Create tab, if necessary.
- Select Report Wizard in the Reports group. Select these fields by clicking on the field names and clicking on the first carat in the middle column:
  - Names, Address, City, State, Zip Code
- Click Next button twice. Sort the records in Ascending Order by 1. City and 2. Names.
- For the Title, change to Client Report—Your name, #DB-5. When you click the Finish button, the Print Preview appears.

Click the FILE button, Print, Print Preview, Print, OK. Close Print Preview. Close Client Report by clicking the small “x” under the Header/Footer group, NOT THE TOP RIGHT “X” THAT CLOSES ACCESS OR THE “X” IN THE FIELD LIST! Turn this assignment in as #DB-5.

Keep this Client Table open for the next assignment.

Assignment #DB-6  Adding a Column, Creating and Printing a Query

The manager of Denver Drivers Training Company would like a Query of all his clients that have paid over $100. He also wants to know their phone numbers, so you will add a Phone No column.

- If necessary, open the Client Table of Denver Drivers Training Co. Change to Design View.
- Select the Address row (click in the grey box in front of Address), click Insert Rows button on ribbon, and enter the field name: Phone Number. Phone field is Short Text. Enter the Description: Phone Number of Clients.
- Return to Datasheet View. Save table when asked.
- Enter Phone Numbers for clients: 1) 702-245-1989  2) 702-275-6428  3) 702-339-5555 and 4) 702-489-0022.
- Click the Create tab. Click Query Design button. In Show Table box, click Add button on bottom. Drag Show Table. Drag bottom margin of Client table down to show all fields through Trainer Number.
- Double click on: Client No, Names, Phone Number, Amount Paid.
- Click in the Criteria of the Amount Paid column, enter >100 (meaning greater than $100). Click the Sort cell in the Amount Paid field and select Ascending. Click Run under File. You should show two clients.

Click File, Print, Print Preview, Click the Print button under File, Click OK. Close Access. Turn this assignment in as #DB-6.
CREATING AND USING A DATABASE QUESTIONS

Choose the most correct answer. These questions may appear on a test. This is assignment #DB-7.

1. If the Access window is not maximized, a short cut is to _______ the title bar.
   A) Click             B) Double-click

2. The Best Fit function has the effect of making columns ________.
   A) Wider  B) Narrower  C) Both A & B

3. How many times should the Primary Key appear beside the fields in the Design View______?
   A) 1            B) 2              C) 3

4. In Print Preview, what do you click to increase the size of the table in order to see it better?
   A) Increase button on Database toolbar
   B) Setup button, Increase Size
   C) Magnifying glass mouse pointer on the table

5. Which print orientation is 11" x 8 1/2" ?
   A) Portrait       B) Landscape

6. Which print orientation is 8 1/2" x 11"?
   A) Portrait       B) Landscape

7. When used as part of a criteria on a grid, the symbol ">" means: _______
   A) Greater than  B) Less than

8. The symbol "<" means: _______
   A) Greater than  B) Less than

9. When entering criteria, which is true? _______
   A) You may use $ but not commas
   B) You may use commas but not $
   C) You do not use $ and commas